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General

Glossary
‘ Term Description
Tool Id A unique tool number. This Id is user defined.
Tool status The status of a tool. The statuses are Available, Warning and Down.

Tool category

The tool type. All tools belong to one of the defined categories.

Tool down time

The hours the tool has been unavailable.

Tool document

Documents connected to the tool.

Booking A booking on a specific tool.

Calendar In the calendar the users can create/edit/view bookings. The calendar
displays one week at a time.

Tool license To book a specific tool the user must have a licence for that tool.

Licence application

Users that need to use (and book) certain tools must apply for a licence.
The application is handled by the tool responsible/instructor.

Tool responsible

A user category. There are 1* and 2" tool responsible. The users in this
category grants licenses and is permitted to edit tool properties.

Practical coach

The practical coach is a user that has helped an applicant using a specific
tool. The practical coach is a user who has licence for that specific tool.

Supervisor When applying for membership in LIMS the applier can name his/her
supervisor.

Instructor A user category that instructs new users how to use tools and grants
licenses.

Project When booking a tool the user have to specify a project.

Batch It is possible to add and edit batches, to be referenced to in log entries.

Night shift booking Certain rules apply when booking tools outside daytime hours. (Optional)

Newsletter Users belonging to one of advanced user roles can create/edit and send
the newsletter.

Sitemap A map over the structure of the website.

Profile All users has a profile which can be edited by the users himself, email,

password etc.

Process line(s)

Tools used in a process flow can be grouped using a process line.

External mail receivers

External (persons not active in the lab) mail addresses that will receive the
newsletters.

Internal info page

The start page for LIMS. The page can be edited by advanced users.

Log

Electronic log book function or an entry in the electronic log book.

Log fields

It is possible to add/create custom log fields on every tool.

Fares and charges

Sets hourly rates, monthly fee etc. Used when handling invoices data.

Favourites

A menu that contains the selected favourites in the LIMS system. The
favourites are user defined and set in the “My Profile” section.




Lists/grids

Lots of pages in the system are “List pages”, like User list, tool list, Booking list, project list, etc.

Common for these pages are that they have a filter with options — depending of type of page.

Optional filters for this list  (Hide filters...)

First name:

User category: - All categories — B
University / s s ;
A - All Universities / Companies -
Laboratory /

o - All except MyFab lab/groups -

[=]
[=]
Apply filters

Last name:

User role: - All active users of the system —
Department: - All departments -

Show del

eted
lab/groups: No B

Add/remove columns (4 of 50 columns chosen)

Some lists have a lot of viewable columns, a logged in user have the option to choose the columns to

Uss Column Name Visible
] First name v
|| testname v

Laboratory / group v

_ | Department
lies — University/company 7
lups || Username ]

Access cardnr

"""""""" Access typeld

Added date

Area restriction typeld

Birthdate

Changed date

Current status changed

Current user arearestriction historyld
Current user laboratorygroup historyld
DeletedDate

Department name

Email

Handle chemical course

Introduction and safetycourse

| Is admin

m

pay
f <
pay

gy
pay

pov

j <
pay
gy
gy

OK \ Cancel H Restore to default H Select all [

fo

i

Quantum Device Physics Laboratory Chalmers University of Technology

Atomic Physics

Géteborg University

User in the lists is clickable. When clicked a small
window with contact information is displayed. It

is also possible to send a message.

user changes them.

view. These settings are saved until the next time the

Each list has some default columns that are showed

if you like (Restore to default button).

the first time. You can always change back to “default”

7
& Send message - Windows Interne... |

lg http://217.16.193.243/LimsSandBox/U

Message to

E-mail: toolpl@sandbox unilims.s2
Phone: 018-4713128
University/Company: TEST_Comp
Laboratory: TEST_CompLab A2

Subject

Message

Send

ocess lines E]

| 1st responsible

Johan Elgh
Johan Elgh
Johan Elgh
Johan Elgh

Records Pe




Roles of the system

The system consists of primary and secondary roles.

Primary roles are: Administrator, User, Project manager, Project leader.

A user of the system must have one of these roles.

The user can also have an optional, secondary role: Instructor or Tool responsible.

An “Administrator” can see and do everything in the system. Booking rules do not apply, with a few
exceptions.

A “User”, the most common role, is a standard user. He can See information, but not change or
add/delete it.

A “Project manager” is basically a “User” who can add and manage projects, while a “Project leader’

4

can manage projects, but not create any new.

The roles “Instructor” and “Tool responsible” opens up menus for editing tools, settings, and allow
licensing of equipment for users.

Use cases

This section describes the workflow when performing some common tasks in LIMS.

Apply for access to LIMS

When a potential user needs access to LIMS, the user has to apply for membership.

Researchers, graduates, students and others that require access to the lab(s) can apply for
membership from the start page by clicking the menu “Membership”.
[ voois | info | Wembershp]

The steps necessary by the applying user are explained in the section Membership.

After a user has sent an application applying for membership in LIMS an administrator has to process
the application, these steps are explained in the section Process application.

Apply for tool licence
If a user needs to book a tool, the user has to have a licence to use that particular tool.

The steps performed when applying tool licenses are described in the section Apply licence.

A tool responsible has to approve or decline applications, these steps are describe in the section
Manage Licence applications.




To book a tool

The core of LIMS is the booking of tools. Booking a tool can be initiated from different sections in
LIMS. The most common way of doing this is from the start page. This is done by clicking “Book” to
the left of one of the tools displayed in the list My Licensed tools and thereafter perform a booking

on that specific tool. The booking procedure is described in the section Book a tool.

Create a log connected to a booking or a tool

The recommended way is to create logs on bookings but some tools are not possible to book. In that
case the user has to create a log directly on that tool.

Logging is usually performed from the start page in the list “My Bookings”.

How to create log on a booking see the section: Log for booked tools.

How to create log on a tool see the section: Log without booking.

Send messages
From within LIMS the user has the option to send messages to the other registered users in LIMS,
how to do this is described in the section: Send Message.



Start page

Home

After a successful login the user is redirected to the start page shown below.

From the start page it is possible for the user to do the most common tasks in LIMS.

iThere are 10 licence applications to process;
iThere are 3 user applications to process:

Important information about the lab

New LIMS functionalities

During the summer LIMS was updated with some new
functionalities for all users:

Licence application form

When you need to apply for a licence you now have to use
the application form found in LIMS. In a Tool View you find
a link to the web form in the Status and Tool description.
You will also find the web form under Tools/Apply for
licence. With this web based application we aim to make
the whole process smoother and more efficient with
reduced number of emails and questions to verify if it is the
right tool and se on. We can also gather statistics for your
waiting time and so on. It is therefore from now on
compulsory to use this form when applying for a licence on
a tool

Calendar subscription

Previously you could export a calendar file for your

Alartranic ralandare Cram naue an it ic naccihla fa

Booked tools

My bookings

(Hide bookings...)

~
il

2

From today and newer ~ Show not completed log ~ Hide log status

v

Logs without booking

(Hide logs...)

a1
&)

From yesterday and newer ~

Show not completed ~

Project leader bookings  (Show bookings...)

¥

Book

Book
Book
Book
Book

The start page contains of following sections:

View
View
View
View

[All licenced tools]

teg

Log
teg

Human resource

Martin Klargvist

My licenced tools

4-point probe - CMT-SR2000N (103)
Evaporator - Opto (408)

Harrys Golvmopp (9901)

Parameter Analyzer - Keithley 4200-SCS (123)

- New license applications and new user applications

- News

- Booked tools, a list of booked tools

- Logs without bookings, a list of logs

- Project leader bookings, a list of bookings

- My licenced tools (Favorites), a list of tools

- My licenced tools (All licenced tools), a list of tools



New license applications and new user applications
At the top of the page, both new licence applications(Tools) and new user applications(LIMS) are
displayed.

EThere are 10 licence applications to process!
iThere are 3 user applications to process|

By clicking the links the user can manage/process these applications.
This section is only shown to the users who manages user applications or licence applications. The
roles who manages applications are administrators and tool responsibles.

News (Internal info page)

The news are displayed under the header “Important information about the lab”.

Users with the role administrator, tool responsible, project manager and instructor are permitted to
edit the internal info page/news page at Home » Advanced » Internal info page.

Important information about the lab

New LIMS functionalities

Prore t woder bowl g

During the summer LIMS was updated with some new
functionalities for all users:

Licence application form

When you need to apply for a licence you now have to use d
the application form found in LIMS. In a Tool View you find
a link to the web form in the Status and Tool description.
You will also find the web form under Tools/Apply for
licence. With this web based application we aim to make
the whole process smoother and more efficient with
reduced number of emails and questions to verify if it is the
right tool and so on. We can also gather statistics for your
waiting time and so on. It is therefore from now on
compulsory to use this form when applying for a licence on
a tool

Calendar subscription

Previously you could export a calendar file for your

Alartranis ralandare Crame naue an it ic naccihla fa



Booked Tools

This section of the start page displays booked tools and started log entries that are not connected to
a booking. See picture below.

Booked tools

My bookings {.;-Iide booi(ings.‘.)‘ rﬁ]
From today and newer ~ Show not completed log ~ Hide log status  ~
Log Edit 20 okt 15:00 - 18:30 Developer baths
Log Edit 22 okt 08:00 - 11:30 4-point probe - CMT-SR2000N

|

)

.Logs without booking  (Hide logs...) [2

[

From yesterday and newer v Show not completed ~

Log 20 okt 09:00 - 10:00 Buffing machine Log: Started

Project leader bookings  (Show bookings...)

3]

The user can edit the bookings and perform logging from any of the lists. This is done by clicking the
links “Edit” (to edit a booking) and "Log” (to create a log on a booking).

My licenced tools
This section lists the tools where the user has a licence. As default, only the tools selected as
favorites are displayed. Favorite tools are selected/deselected at Home » Tools » My licenced tools.

New | IMS functionalities

- e

-t g

LD o S N -

o gl - b

My licenced tools

Book
Book
Book
Book

To see all licenced tools the user has to click the link “[All licenced tools]”. See picture below.

My licenced tools

Book View tLesg 4-point probe - CMT-SR2000N (103)

Book View tes Evaporator - Opto (408)

Book View Log Harrys Golvmopp (9501)

Book View tes Parameter Analyzer - Keithley 4200-SCS (123)
Book View tesg Buffing machine (507)

Book View Log Cleaning-solvents (1002)

Book View tes CNT CVD (440)

Book View Log Developer baths (208)

Book View Log Developer spinner BLE De (204)

Book View teg Electroplating- Acid (621)

Book View Log Surface profiler, stylus - Tencor AS500 (230)
Book View teg Vacuum package (510)

As seen above the user has the choice to perform bookings, perform logging or view the tool
information in the list. This is done by clicking the links “Book” (to book a tool), “View” (to view a tool
information page) and "Log” (to create a log on a tool without booking).



Tools
Home » Tools

The “Tools” menu is accessible to all users of the system.

oo v [ |

My licenced tools

Apply for licence

All tools

Tool status

View bookings

Batches

Log

Verify night shift booking

View Tool

This page is opened from several different tool lists like “All tools”, “Tool list”, “My Licensed tools”

etc. View tool shows standard information, viewable to all users.

Tool Name:

Tool 1d:
Manufacturer:
Model:
Category:

Tool responsible:
Second tool responsible:
Process responsible:
Tool Owner:
Responsible group:

Is deleted:

Tool rate (A is lowest rate, E is
highest):

Booking type:

Log level:

Max bookingtime, daytime:

Max bookingtime, nighttime:
Future bookingtime, day time:
Future bockingtime, night time:
Total number of future bookings:

Current status: AVAILABLE [Change] -

Status and tool description

Additional information

Microscope - Olympus AH3
(vanox)

102

Olympus

AH3

Metrology

Orjan Arthursson [contact]
Johan Andersson [contact]

Nanofabrication Laboratory

No

A
Unbookable
Optional

4 hours.
4 hours.
8 hours.
[no limit]
5

Area / room: Processlab 1
Footprint [m2]:

Installation Date:

Next calibrate date:

Process Lines:

Instructors: [...]
Licensed users: [...]

Current files:
Tool Manual
tooldocument.txt [info]



My licensed tools
Home » Tools » My Licensed Tools

The page displays a list of the tools where the user has licence.

My licenced tools

)

Optional filters for this list  (Hide filters...)

Tool Id: Tool name:
Category: - All categories - v Status: ~Al-  ~
Responsible: — All tool responsible - ~ Booking type: -- All booking types - v

Apply filters |

Add/remove columns (5 of 36 columns chosen)

Tool Id & Name | Category Booking Status Favorite
Book View tog 103 4-point probe - CMT-SR2000N Metrology Compulsory Avzilable Remove
Book View tog 123 Parameter Analyzer - Keithley 4200-5CS Metrology Compulsory Available Remove
Book View Log 204 Developer spinner BLE De Wet process benches Optional Available Add
Book View Log 208 Developer baths Wet process benches Optional Available Add

As seen above the user is able to perform bookings, perform logging or viewing the tool in the list.
This is done by clicking the links “Book” (to book a tool), “View” (to view a tool) and “Log” (to create
a log on a tool without booking).

It is also possible for the user to add or remove a tool as a favourite tool. The favourite tools are seen
at the top of the list “My Licenced tools” in the LIMS start page.

How to create log on a booking see the section: Log for booked tools.

How to book a tool is described in the next section: Book a tool.



Book a tool
From the list described above (My licenced tools) the user clicks the link “Book” to start booking a
tool.

When clicking the link “Book” a calendar is displayed, all bookings are made in this calendar view. See
picture below.

‘Year:ZMOEI (408)___Evaporator - Opto E] Sort: id B ‘
(408)__ Evaporator - Opto, Week 43
Week Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec
43 [+] [ 01]02]o3]o4]os]os]07]os]oa]10]11]12]13]14]15]16] 17] 18] 19] 20]21] 22] 23] 24] 25 26] 27] 28] 29[ 30] 31
KBER | von2510 | Tue26M0 | Wed27/10 | Thu28/10 Fri 29/10 Sat30/10 | Sun31/10
0:00
1:00
200
3:00
4:00
5:00
=on

Booking is made by clicking the start time and end time in the calendar. See picture below.

vy

7:00 Ron -
Bookinginformation

8:00 Starttime: 2010-10-29 09:00

Endtime:
Close

9:00

10:00

‘:l Show own bookings

Close this window |

12:00 [

After clicking the end time a popup is displayed where the user selects project, batch no (optional)
and confirms the booking by clicking the button named “Book”. See picture below.

Year: 2010+ (408)__Evaporator - Opto [+] sotic  [+] I
Week Jan | Feb | Mar | Apr | May | Jun | Jul | Aug | Sep | Oct | Nov | Dec || |Se"e™
43 [+] | 01]02[03]o4]os]os]o7]os[os[10]11]12[13[14[15]16] 17[18]19]20[21]22]23]24]25 6] 27[28]28]30]31]| | Booking rutes
EBEE | von2510 | Tue26M0 | Wed27/10 | Thu28M0 Fri 20110 Sat30/10 | Sun31/0 | |1 Min booking time: 30 minutes
0:00 2. Max booking time, daytime: 8 hours
3. Max booking time, nighttime: 8 hours
100 4. Future booking time, day time: 16 of 16 hours left
S. Future booking time, night time: [No limit]
6. No. of future bookings: 5 of 5 bookings left

/& Create booking - Windows Internet Explorer @1&]

Bookinginformation (Posted by Henrik Frederiksen)
Please keep the plastic implosion guard on ALL the time

when the chamber is under vacuum.

Tool: Evaporator - Opto

Starttime: 2010-10-29 09:00

Endtime: 2010-10-29 11:00 Bookinginformation

Project: Nanofabrication Laboratory E Startt 2010-10-29 09:00
arttime: -10-29

Supplymentary - - Endtime: 2010-10-29 10:58

Information - Close

Batch no: [ Verify J

e

¥ show own bookings

! Close this window




After confirmation the booking is displayed in the calendar as shown in picture below.

7:00

[E Show own bookings
8:00

Close this window
$:00 Martin
Klargvist

10:00

show/hide color description
11:00

I I

By selecting another tool at the top of the page the user can book several tools at once.
The bookings for the selected tool are displayed in blue. Other tool bookings made by the user are
displayed in green. See pictures below.

€ myFab Booking - Windows Internet Explorer
| Year: 2010 E (208)___Developer baths
1(208)___Developer baths
{220)___Surface profiler, stylus - Tencor AS500
(208)__ Developer baths, Week 44 {408)___Evaporator - Opto
(440)___CNT CVD i
Week Jan | Feb | Mar | [CAEECII T [Ellnov | Dec
= = = {510)__Vacuum package | o e
2 [o][o1 ]04 | G3| G‘Icf | 08 |°7|°E‘ (621)__ Electroplating- Acid E °|2’ I‘8|49 30
KBER | vonoun Tue 02/11|(1002)_Cleaning-solvents Sun 07/11
‘ (4548)__Newton vaggs
0:00 (S87€)__Testtool
{9901)__Harry’s Golvmopp
2:00
4:00
5:.00
6:00
7:00
8:00
g:00 quis
10:00
11:00
12:00
13:00
14:00

The easiest way to edit a tool booking is simply to click the link “Edit” from the list Booked Tools at
the Start page.

There are a number of rules and settings affecting the booking of tools. These are described in the
section Booking in LIMS.



Apply for licence
Home » Tools » Apply for licence

In this page any user can apply for a tool licence.

The three different dates are suggestions for the necessary overhaul done by a tool responsible or an
instructor. The practical coach is another user who has licence for that tool. The practical coach must
be a user that has helped the applicant using the specific tool.

The application is sent by mail to 1% or 2" tool responsible and all instructors for that tool. When the
license is confirmed by a tool responsible or instructor the user receives a “driving” license for that
tool. This means that the user is allowed to book and use that tool.

Apply for licence

Please fill the form with information regarding your license.

Tool 106 Microscope - Olympus MX40
Primary:
Possible dates 2010-10-12 ETI
Secondary:
2010-10-13 %
Third:
2010-10-14 %
Estimated uses 12 hours
(in period of 6 month)
Practical coach Mad

(on this tool) : _
Short info of intended Biddut Kumar Banik
nse Kumar Manohar
Marcello Marelli
Maria Sundh
Mariana Ungureanu
Marie Sonestedt
Marius Mikolajunas
Markus Happel
Markus Schwind
[Martin Fagerlin
Martin Gustafsson
T @ard andinatine | [Martin Jonsson
Send application Martin Klargvist

Martin Narlina




All tools

Home » Tools » All tools

This page lists all tools registered in the system. It is possible to do some filtering to narrow down the
number of tools displayed.

To book a tool click the link “Book”.

To view the details click the link “View”.

To perform logging, click the link “Log”.

All tools
Optional filters for this list ~ (Hide filters...) &)
Tool Id: Tool name:
Category: - All categories - - Process line: - All process lines - ~

Add/remove columns (5 of 32 columns chosen)

Name Tool Id | Manufacturer Process Instructors
- responsible
Book View Log Microscope - Olympus AH3 (Vanox) 102 Olympus
Book View tog 4-point probe - CMT-SR2000N 103 Doktor Snuggles Svante Palsson
Book View Log Ellipsometer - Sagax Iscoscope 104 Sagax
Book View Log Ellipsometer - Rudolph AutoEL-1I 105 Rudolph
Book View Log Microscope - Olympus MX40 106 _ Aldo Instr
Jesorka
Book View tog Surface profiler, stylus - Tencor P15 108
Book View tog SEM - JEOL JSM-6301F 110 JEOL Ltd.
Book View tog SPM - DI Dimension 3000 SPM 111
Book View tog Ellipsometer - J.A. Woollam M2000 112 J1.A. Wollam
Book View tog Surface profiler, optical - Wyko NT 1100 114 Wyko
Book View tog SEM - Zeiss Supra 60 VP (IXRF EDX) 116 Zeiss Piotr Jedrasik
Book View Log Macro photo system 118
Book View tog X-ray Diffractometer 120 Philips
Book View tog Parameter Analyzer - Keithley 4200-SCS 123 Keithley Géoran Alestig
Book View Log Microscope - Olympus MX50 125
Book View Log Microscope stereo - Olympus SZH-10 126
Book View Log IR Wafer Inspection System 127
Book View Log Ozone Cleaning System Novascan 130 Novascan Orjan Arthursson
Book View Log Offline analysis(SPM/Ellipsometry/L- 140 HP
dravi/ AutoCAD

Rank Viaw tmn Dhatalithanranhy Gtannar - AGMI DAG 201 acmi



Tool status
Home » Tools » Tool status

This page lists all tools registered in the system displaying their current status.
It is possible to do some filtering to narrow down the number of tools displayed.

Users with proper permissions can change the status for a tool by clicking the link “Change status”.

Status for tools

Optional filters for this list  (Hide filters...) &
Category: — All categories - v Status: -Al- =~
Responsible: - All tool responsibles - Booking Type: -- All booking types - v

Add/remove columns (4 of 30 columns chosen)

Current Status I Actions Name Tool Id o | Category
Available Change status  Microscope - Olympus AH3 (Vanox) 102 Metrology
Available Change status  4-point probe - CMT-SR2000N 103 Metrology
Available Change status Ellipsometer - Sagax Iscoscope 104 Metrology
Available Change status Ellipsometer - Rudolph AutoEL-II 105 Metrology
Available Change status Microscope - Olympus MX40 106 Metrology
Available Change status  Surface profiler, stylus - Tencor P15 108 Metrology
Available Change status SEM - JEOL JSM-6301F 110 Metrology
Available Change status SPM - DI Dimension 3000 SPM 111 Metrology
Available Change status Ellipsometer - J.LA. Woollam M2000 112 Metrology
Available Change status  Surface profiler, optical - Wyko NT 1100 114 Metrology
Available Change status SEM - Zeiss Supra 60 VP (IXRF EDX) 116 Metrology
Available Change status Macro photo system 118 Metrology
Available Change status  X-ray Diffractometer 120 Metrology
Available Change status Parameter Analyzer - Keithley 4200-5CS 123 Metrology
Availabl Ch status Microscooe - Olvmpus MX50 125 Metroloav

The popup window used to change tool status, see picture below.

[ @& Change status/ for tool - lE’ 5] lﬁ

Change status/message for tool

Status: Available (current status)
Available (current status)
Warning

Down




When the user changes the tool status it will probably affect the bookings made on that tool.

Status change Effect

Available -> Warning When a booking is made a warning message will be displayed to
the user.

Available/Warning -> All future bookings will be deleted. If a booking spans into the

Down down period that booking will be shortened to the nearest

available % hour.

Down -> If licenced users to that tool has activated e-mail notifications in
Available/Warning “My Profile” they will receive a notification e-mail when a tool
status changes from “Down”.

The setting in that activates e-mail notification, see picture below.

My Profile

Personal Info
Change Password

Email Settings

| Receive e-mail when a (licenced) tool is available again after being down: No

Save changes



View bookings
Home » Tools » View Bookings

This part of the application give the users an overview of their own bookings and the opportunity
overview other bookings as well.

Tools —~— O o =t St
My licenced tools
Apply for licence
All tools

¢ Tool status

View bookings » My bookings
Batches » All bockings
Log » Booking overview

Verify night shift booking

CUURINIY UV el Vi | '

My bookings
Home » Tools » View Bookings » My bookings

The page is an overview of the bookings made by the user. The listed bookings can also be edited,
viewed and deleted.

To edit a booking click “Edit” in the list.

Bookings can be deleted by selecting booking(s) and pressing the button “Delete checked bookings”.
The user can also perform logging by clicking the link “Log”.

My bookings
oktober 2010 Bl Ovtional filters for this list  (Hide filters...)
Month ma ti onto fr 16 - =
12 3 Tool: - All my licensed tools - ~ Sort:id
4 56 7 8 9 10 Project: - All projects - v

11 12 13 [ERERG 17| | e
18 19 20 2122 23 24| | Fromdate: 2010-10-12 £ 1o date: 2010-10-22 EF Display bookings

25 26 27 2829 30 31

Add/remove columns (7 of 27 columns chosen)

‘ A | | Starta Stop Tool name [Tool 1d [ Project | Batch | Log status.
7] Edit Log 2010-10-14 11:00 2010-10-14 17:30 Harrys pp 9901 icati L: 4 Started
Edit Log 2010-10-15 17:00 2010-10-15 21:30 Vacuum package 510 Nanofabrication Laboratory Not Started (Optional)
& Edit Log 2010-10-16 07:00 2010-10-16 09:30 Developer baths 208 Nanofabrication Laboratory Not Started (Optional)
| ShowPage: 1 (Total Recordst 3) B Records PerPage:  qg ., |

[ Delete checked bookings




All bookings
Home » Tools » View Bookings » All bookings

The page lists all bookings for a tool AND/OR a project during a period of time.
In the example below the user is listing all bookings in the project “Nanofabrication Laboratory”.

The listed bookings can also be edited, viewed and deleted.

To edit a booking click “Edit” in the list.

Bookings can be deleted by selecting booking(s) and pressing the button “Delete checked bookings”.
The user can also perform logging by clicking the link “Log”.

All bookings

oktober 2010 Optional filters for this list  (Hide filters...) &)
Month m3 ti onto fr 16 s6
Week 27 282930 1 2 3
Week 4 5 6 7 8 9 10 Project: Nanofabrication Laboratory ~

week 11 12 13 [ERERT 17 = - -
Week 18 19 20 21 22 23 24 From date: 2010-10-12 B 1o date: 2010-12-31 F9 Display bookings |

Week 25 26 27 28 29 30 31
Week 1 2 3 4 5 6 7

Tool: - All tools - v Sort: id v

Add/remove columns (7 of 27 columns chosen)

| [ | Edit | Log | Start & Stop Tool name I Tool id | Project Batch | Log status
L]
[F1 Edit Log 2010-10-14 11:00 2010-10-14 17:30 Harrys Golvmopp 9901 Nanofabrication Laboratory Started
A Edit Log 2010-10-15 17:00 2010-10-15 21:30 Vacuum package 510 Nanofabrication Laboratory Not Started (Optional)
Edit Log 2010-10-16 07:00 2010-10-16 09:30 Developer baths 208 Nanofabrication Laboratory Not Started (Optional)
‘ Show Page: 1 (Total Records: 3) X Records Per Page: 10 « l

l Delete checked bookings

Booking overview
Home » Tools » View Bookings » Booking overview

This page displays an overview of bookings the selected date.
It is possible to see all bookings the selected day by setting the filter seen below.

Tools booked view

9 use filter "' My favorites Day and night shiﬁE
Optional filters for this list  (Hide filters...) &l

m3 ti on to fr 16 so 7

27 28 2930 1 2 3 Category: — All categories - [+] Status: ~Al- [+]

4 5.6 .7 Bi9% 10 Responsible: — Al tool responsible [~ Booking type: ~ All booking types ~[ =]

1 12[]14 15 16 17| |

18:119) 20,1121 22. 23 24 Onlylicenced tnols [¥] show only tools with bookings

25 26 27 28 29 30 31 9 All tools

r 23 4567 Applyﬁlters\

Favorites Tools 0 1 2 3 4 5 6 7 8 2 0 |SRE (5328 [5230 234 |SFSY [226- 2275 |538: [529% [20c |24 7228 [-23,
A SPM - Veeco Dimension 3000 SPM
Add p \
(111)
Add Parameter Analyzer - Keithley 4200-
3 SCS (123)
Add Mask aligner - KS MA/

Add Mask aligner - KS M.

Add EBL - JEOL 1BX-9300FS (217)

Add Resist spinner I11/V and nano (218)
Add EBL - JEOL JBX-5DII (264)

Add Mask aligner - KS MIB3-UV 400 (268)
Add

s Plasmalab Sysf

Add Sputter - Balzers PLS 550 (407)

Add Evaporator - Opto (408)

Add Ion Beam Milling S-{stem -CAIBE

Oxford Ionfab (417)



Batches
Home » Tools » Batches

In this section the users have the possibility to view and manage batches.

e —————————————]

My licenced tools

Apply for licence

All tools
¢ Tool status
View bookings »
Batches » Batch list
Leg » Add batch

Verify night shift booking Log history by batch

Log history by tool

Batch list
Home » Tools » Batches » Batch list

The page lists batches in the system. By changing the filter it is possible to see all batches.
The user has the possibility to edit/change the batch by clicking the link “edit”.
It is also possible to display the log history by clicking the link “History”.

Batch list

‘|

Optional filters for this list  (Hide filters...)

1551
1

Batch id: Batch name:

Start date from:  2010-04-01 9 Batch status:

Apply filters

Planned and 'In progress’ v

Add/remove columns (7 of 15 columns chosen)

Batch |Master | Project Labuser |Startdate |Enddate |Batch Supplementary | Responsible | Nrof
name | batchid status | info user wafers
Edit History martin Nanofabrication ~ Martin 2010-04-05 2010-06-30 In 216 12
test's Laboratory Klarquist Progress
Edit History test3 Myfab MSL Martin 2010-04-05 Planned 216
Klarquist
| ShowPage: 1  (Total Records: 2) [®] Records Per Page: 10 |

Log history by batch
Home » Tools » Batches » Log history by batch

This page lists all log entries where the user has entered a batch number/name in that specific log
entry.

Log history by batch

Optional filters for this list  (ide filters...)

2]

Batch id: Satch name:
Batch owner: — Al projects where | am a member — -
View logs from:  2010-01-01 ¥ to: B2 Apply filters |
Add/remove columns (13 of 31 columns chosen)
User a Tool name Project | Project name Start Stop Timespan | Supplementary info | BatchId | Batch Completed | All
1d date logfields
Mask aligner - KS 594126 BioNano MC2 2010-09-28 15:00 2010-09-28 16:30 1,5 28
MA/BA 6, #1
Developer baths 79 Nanofabrication 2010-10-03 09:00 2010-10-03 10:30 1,5 28
Laboratory
Electroplating- Acid 79 Nanofabrication 2010-10-03 14:00 2010-10-03 15:30 1,5 28
Laboratory
Vacuum package 79 Nanofabrication 2010-10-15 17:00 2010-10-15 21:30 4,5 28
Laboratory
Developer baths 79 Nanofabrication 2010-10-16 07:00 2010-10-16 09:30 2,5 28
Laboratory

Show Page: 1

(Total Records: 8)

¥ Records Per Page: 10 +




Log history by tool

Home » Tools » Batches » Log history by tool

This page lists log entries by a specific tool where the user has entered a batch number/name in that

specific log entry.

Log history by tool

Optional filters for this list ~ (Hide filters...) 5]
User: Type to see suggestio
Project: - All projects - ¥
View logs frams 20090913 £7 to: B
Batch info: Only show logs with batch info ~
Tool: 208 Developer baths ~ Sort: id v | Apply filters |
Tool log level: Optional
Add/remove columns (11 of 30 columns chosen)
Usera Toolname | Project | Project name Start Stop Batchld CompletedDate v
Id info
79 Nanofabrication 2010-10-03 09:00 2010-10-03 10:30 1,5 28
Laboratory
79 Nanofabrication 2010-10-16 07:00 2010-10-16 09:30 2,5 28
Laboratory

IShow Page: 1 (Total Records: 2)

[ Records Per Page: 10 ~ I

Log

Home » Tools » Log

This section provides the user with a summary / overview of the logs created.

Log status
Home » Tools » Log » Log Status

This list displays logs and their status, see picture below.

Only the users own bookings are displayed in the list.

Log status

-- Select tool here to start new log or create new booking —-E] Sort: id

[=]

Optional filters for this list  (Hide filters...)

[»]

Show all

ShowE]

2008-10-16 E7 to:

Show logs:

[=]

Logs for project
leader bookings:

Bl

Timespan:

Log status:

Optional logs:

Show all

Show

Type to see suggestion (mir characters | View logs

Add/remove columns (8 of 12 columns chosen)

| | Log / Booking Start o | Log / Booking Stop | Booked / logged by | Log Status

Completed date

Log 27 okt 05:30 27 okt 12:30
Log 29 okt 12:30 29 okt 14:30
Log 3 nov 11:30 3 nov 14:30
Log 8 nov 15:00 8 nov 17:30
Log 12 nov 16:00 12 nov 17:30

Not Started (Optional)
Completed

Started

Started

Not Started (Optional)

2010-10-26 16:48:35

[ Tool 1d [ Tool Name All log fields
208 Developer baths
205  Mask aligner - KS MA/BA 6, =1
501 Hotplates and ovens LCD
501 Hotplates and ovens LCD
501 Hotplates and ovens LCD

I Show Page: 1 (Total Records: 5)

[®] Records Per Page: 10E| I

The user can create a log or continue logging by clicking the link “Log”.

In this page the user also has the option to create logs directly on a tool or to create a booking. See

the picture below. To create a booking on the selected tool just press the button “New booking” and

to create a log just press the button “New log”.

Log status
103 4-point probe - CMT-SR2000N

[+] sort:id

E| [ New log | | New booking




Create a log on a booking / Log for booked tools
The user can create a log or continue logging by clicking the link “Log” in the list displaying

When creating a new log or continues logging on a booking the page below is displayed.

Log for booked tools

Vacuum package (510)

Booked time: 24 sep 11:00 - 13:00

Project: BioNano MC2

Batch No: Verify I
Log start time: 2009-09-24 5 11:00

Log end time: 2009-09-24 % 13:00

| Problems during run
(If checked, supplying supplementary info about what went wrong is required
Also, any required log fields are changed to optional)

Supplementary
Information:

- Change status or message for this tool (current status: Available)

[ Save as 'Started’ H Save as ‘Completed’ ‘

When pressing the button “Save as ‘Started’” the log is marked “Started” and not closed, it is
possible to perform more logging on that booking. If the button “Save as ‘Completed’” is pressed the
log on that booking is marked “Completed”, logging is not supposed to continue on that booking.



Create alog on a tool / Log without booking

In this page the user also has the option to create logs directly on a tool or to create a booking. See
the picture below. To create a booking on the selected tool just press the button “New booking” and
to create a log just press the button “New log”.

Log status_
N e e N~ | Sort:id  [~] [ Newlog ] [ New booking |

When creating a log on a tool without booking the page below is displayed.

Log without booking

Tool: Macro photo system (118)
Project: Atomic Physics E]
Batch No: @J
Log start time: 2010-10-26 ¥ 09:00

Log end time: 2010-10-26 % 10:00

[l problems during run
(If checked, supplying supplementary info about what went wrong is required
Also, any required log fields are changed to optional)

Supplementary
Information:

- Change status or message for this tool (current status: Available)

{ Save as ‘Started’ ] [ Save as ‘Completed’ J

The functionality of the buttons is the same as for Log for booked tools.

Log history by tool
Home » Tools » Log » Log history by tool

Same as described in section Log history by tool.

Log history by batch
Home » Tools » Log » Log history by batch

Same as described in section Log history by batch.

Verify night shift booking
Home » Tools » Verify night shift booking

This page helps users to find lab buddies during night shift.
Users search for bookings during the period of their lab stay.

Verify night shift booking

Search for a lab buddy by entering the start time and end time of your lab stay:

I will be in lab between: 2010-10-15 9 18:00 v and 2010-10-16 [ 08:00 ~

9 Select lab buddy from list

Select lab buddy by entering name Ok



If there are bookings during selected period they will be shown in the list.
Verify night shift booking

Search for a lab buddy by entering the start time and end time of your lab stay:
1 will be in lab between: 2010-10-15 7 EEHD] v ang 2010-10-16  E 08:00

© Select lab buddy from list

Select lab buddy by entering name

Made booki during t
| I First name 4 | Last name | Start I Stop
Sele 2010-10-15 14:30 2010-10-15 23:30
Select 2010-10-16 07:00 2010-10-16 09:30
Select 2010-10-1517:00 2010-10-15 21:30
| Show Page: 1 (Total Records: 3) Records Per Page: 10 « |

Verified users in the lab

No lab buddies found!

A lab buddy is selected by clicking the link “select”.

After selecting a lab buddy the user must confirm/complete the verification and optionally supply

some extra information.
Verify night shift booking

Search for a lab buddy by entering the start time and end time of your lab stay:

1 will be in lab between: 2010-10-15 9 18:00 v ang 2010-10-16 9 08:00 v

© select lab buddy from list

Select lab buddy by entering name Ok

Time: 15 Oct 18:00 to 16 Oct 08:00
Lab buddy: S

Supplementary information:

[ Cancel \ [ Complete verification }

Made bookings during timespan

| ‘ First name a | Last name | Start Stop

2010-10-15 14:30 2010-10-15 23:30
Select 2010-10-16 07:00 2010-10-16 09:30
Select 2010-10-15 17:00 2010-10-15 21:30
| ShowPage: 1 (Total Records: 3) Records Per Page:  1g o |

Verified users in the lab

No lab buddies found!

An e-mail is sent to the selected lab buddy upon confirmation.
The confirmed lab buddy is shown in the list “Verified users in the lab”, see picture below.

Verify night shift booking
Search for a lab buddy by entering the start time and end time of your lab stay:

I will be in lab between: 2010-10-15 £ 18:00 v ang 2010-10-16  [FF 08:00 ~

© Select lab buddy from list

_ Select Iab buddy by entering name

Made bookings during timespan

First name & Last name I Start Stop
3 2010-10-15 14:30 2010-10-15 23:30
Select 2010-10-16 07:00 2010-10-16 09:30
Select 2010-10-15 17:00 2010-10-15 21:30
| ShowPage: 1 (Total Records: 3) Records Per Page: 10 |

Verified users in the lab

| Select [ Remove I User1a User 2 Start Stop Supplementary Information |
1 User2 Remove 15 okt 18:00 16 okt 08:00 Lets viork togheter !

|Shovl Page: 1 (Total Records: 1) Records Per Page: 10 o |




User

Home » User

My profile

My statistics
Send message

User list

All users have access to the “User” menu.

In this section it is possible to:
- View and edit my own profile
- View some statistics over my bookings.
- Send messages to other users

- View some user information of other users.

My Profile

Home » User » My Profile

There are five sections in “My Profile”, “Personal Info”, “Change Password”, “Email Settings”, “User
Settings” and “Favorites”. In the different sections the logged in user can view and edit his/her
settings.

Personal Info
To change the settings, simply edit the fields and press the button “Save Changes”.

My Profile
Personal Info
i Username: intiro 4
! Name: Martin Klargvist remove image H

i Phone, work:
! Phone, mobile: 0700-500800

| E-mail: lims@gmail.com New image:

: [T update E-mail in nodes

i [[update E-mail in portal

Save changes

Change Password
Email Settings



Change Password

In this section the user can change the password by entering a new password and press the button
called “Change Password”. If the checkbox called “Update password in nodes” is checked the
password change is made in other connected LIMS nodes as well. If the checkbox called “Update
password in portal” is checked the password will be updated in the portal as well.

It is possible to distribute the current password to the other LIMS-nodes by clicking the link “Set this
password as password in other nodes”. In this case it is not necessary to change the password, just
click the link and the password will be the same in all LIMS-nodes.

My Profile

Personal Info

Change Password

Change Your Password

Password:
New Password:

Confirm New Password:

Change Password H Cancel ]

]} Update password in nodes

[l update password in portal

this

ord in other nodes

Email Settings

Favorites

Email settings
This section allows the user to change the personal Email settings.

My Profile

Personal Info
Change Password

Email Settings

Show a link for sending my future bookings as an ICal-file. Yes v
Receive e-mail when a (licenced) tool is available again after being down: No +«
Send a confirmation mail whenever an action causes a mail being sent to user(s): Yes v

| Save changes

User Settings
This section allows the user to change settings:

- My default project when booking

- Use simultaneous booking windows.
When booking in the calendar, more than one booking window can be open at a time.

- Default timeout for login.
The time before the user will be logged out due to inactivity.

- UseiCalendar-feed.
If checked the user gets a link that can be imported to a calendar.



By clicking the link “Show” the link to the iCalendar feed is shown.

My Profile

Personal Info
Change Password

Email Settings

User Settings

My default project when booking: 79, Nanofabrication Laboratory ~
1 Use simultaneous booking windows: Yes
Default timeout for login: 45 v

Use iCalender-feed ¥ show

Cut
Copy
Paste
Select All
Print...

Print Preview...

Google Sidewiki...

By copying the link into a calendar that supports iCalendar (like the Google calendar) the user’s
future bookings is shown in the calendar.
See picture below.

iCalendar Example 1 — MonoCalendar:

2] MonoCalendar 0.7.2 E@&

File Edit View Help

© [[=ed | © 50w [[WeskJE Mot @2 2

2010  Mon, Sep 27 Tue, Sep 28 Wed, Sep 29 Thu, Sep 30 Fri, Oct 1 Sat, Oct 2 Sun, Oct 3
(¥ Personal 800 A
™ work 8:00
NFL #123 -
9:00 Parameter
Analyzer - Keith
10:00
11:00 10:30
NFL #123 -
Parameter
12:00 Analyzer - Keith i
13:00 12:30
NFL #510 -
Vacuum
14:00 package
15:00 1
15:00
NFL #621 -
- - v
16:00 Electroplating-
September 2010 Acid
MTWTFSS :
17:00 16:30
123 45 NFL #204 -
Developer ™
6 7 8 9101112 500 spinner BLE De
13 14 15 16 17 18 19 s
20 2122 2324 25 26
27 28 29 30 19:00




iCalendar Example 2 - Google Calendar

@ Google Kalender - Windows Interet Explorer [=]E s
(AT [&] ntps | OK1-r0K-32VEb6pWg - & [49] x| Googie 2 -
% 4t | @ Google Kalender ‘7‘ o~ v i@ v [ Page v {F Tooks v
Gmail Kalender Dokument Webben Reader mer v il.com | Offine | & | ingar v | Halo | Logga ut
GO\)S[C kalender Sok i mina kalendrar | Visa sokaternativ

Skapa handelse Idag [ N3 den 27 sep — den 3 okt 2010 | USkivut Uppdatera Dag | Vecka =Manad | 4 dagar = Program
den september man 9127 tis 9/28 ons 9/29 tors 9/30 fre 10/11 for 1072 s6n 10/3
wigoee oo

M T OTF L S -

112 3 4 5 | o0

6 7 8 9 10 11 12

13 14 15 16 17 18 19 07:00

20 21 22 23 24 25 26 e — ;

INFL #213 - Mask

27 28 29 30 1 2 3 £
: : 3600 INFL #213 - Mask

aligner - KS alianer - KS

Mina kalendrar =/} 09:00
pepparkaksmannen@g.
Iriand 3 8| 1000
Listor g
Lagg il Iningar L
11:00 E
Andra kalendrar =
12:00 S
0 aligner - KS
MyFab 4 MA/BA 6, 22
Svenska helgdagar 13:00
Veckonummer i
Laga il v | Instéliningar 14:00
15:00 MA/BA 6, #2
16:00
17:00 -
@ Internet | Protected Mode: Off #100% v

Favorites are created by checking different sections, see picture below to the left.
The selected sections is displayed as “Favorites” in the left hand menu, see picture to the right.

My Profile

oo [

Calendar
| Tools: ; Send my bookings
[C1My licenced tools [7] Apply for licence [T1 Al tools [T Tool status ‘
View bookings: : Related
] My bookings [an bockings ] Booking overview :
: : Tools >
| Batches: H
1 [[eatch list : User 1 2
|| Add batch [7] Log history by batch [7] Log history by tool : Advanced 'S
. Log: :
[T Log status : Admin »
] Log history by tool ] Log history by batch : Info | 3
[] verify night shift booking :
: : Favorites [edit]
! User: i 3
R 7 ) My bookings
' | My profile H
I i ! Send message
| My statistics [V] send message [T user list .
Advanced: : I di .
! Trol recnancihle: ; You are logged in as:




My Statistics
Home » User » My Statistics

Statistics is presented to the user, see picture below.

The data displayed is a summary of the bookings performed by the logged in user during selected
period.

My statistics

Optional filters for this list  (Hide filters...)

© Predefined time period 2010 v Oct 2010 -
Custom time period = =
Note: Booked and logged hours are for all bookings and logs that end within the selected time period.

Batch id: Batch name:

- All my projects - v Apply filters

Project:

Project Id | Project Name

[ Tool 1d [ Tool Name
79

Nanofabrication Laboratory 208
79 ication L

[ Batch [ Booked hours | Logged hours
1.5

Developer baths

y 204 D spinner BLE De 1.5
79 L y 621 ing- Acid 1,5
79 Nanofabrication Laboratory 9901 Harrys Golvmopp 4
79 ication L y 123 Analyzer - Keithley 4200-5CS 3
79 Nanofabrication Laboratory 510 Vacuum package 1.5

13 0
Export to excel



Send message

Home » User » Send message

This page enables the user to send messages to other users registered in LIMS.

Send Message

Send email to: - Send message to. "

Enter Subject: |eelal oIS

One user

Enter Message: |Several users
Tool responsible

Users of a specific tool
The booking system administrator

Attach file(s) | Browse... |
Add attachment

[ SendMail |

The user first selects a recipient type in the drop down box.
When a recipient type is selected the page changes appearance and the user is presented with
different options:

- Oneuser.
A text field is shown.
Use the text field to enter the name of a user.
The text field will display a list of users when entering the name.

- Several users.
Displays a list of all users with filtering options.

- Tool responsible.
Displays a drop down box containing all tools.

- Users of a specific tool.
Displays a drop down box containing all tools.

- The booking system administrator.

After selecting recipient type the user selects the actual recipient(s) and enters subject, the message
text and attaches file(s).



User list
Home » User » User list

Displays users in LIMS, all users can be listed here.

User list
Optional filters for this list  (Hide filters...) &
First name: Last name:
User category: - All categories — v User role: - All active users of the system —
University / 3 e S ;
Company: - All Universities / Companies - v Department: - All departments -
(L;arl:)ﬂ;a.tory - All Laboratories / Groups — - Apply filters

Add/remove columns (4 of 15 columns chosen)

I First name a

I Last name

Email I Phone, mobile

IHMNEDNEDD M &

Abdelrahim
Ahmed Eltahir
Aik Yean

Alar Tool R
Aldo Instr

Alex
Alexander
Alexander

Alexandra

[ 3]

Aleyandri

Ahmed
Elsharif

Tang ProjMngr
Ainlz

Jesorka

Meyer
Dmitriev
Tzalenchuk
Nafari

Viad

abdelraa@student.chalmers.se

elsharif@student.chalmers.se 0762316215
aikt@student.chalmers.se 0704438507
alara@ut.ee 0704308636
aldo@chalmers.se 44556
alexme@student.chalmers.se 0765 83 89 93
alexd@chalmers.se

at2@npl.co.uk 447834270747
alexandra.nafari@chalmers.se 0705300697
alevandriviad®urlnuvain.he +22494770N92



Advanced

Four different roles have access to the “Advanced” section. Users with the roles: Instructor, Tool

Responsible, Project Manager and Administrator.

Tool Responsible

The Advanced menu for users with the Role “Tool Responsible”.

I T

Tool responsible » My tools

Newsletter Tool timeblocking

Internal info page Allow/Disallow mail subject "booking cancelled"
Tags » Licences by user

Tool downtime Licences by tool

Tool history Licences applications

Instructors by user

Instructors by tool

Log fields

Maintenance log fields

Service log fields

My Tools

Home » Advanced » Tool responsible » My tools

The page displays a list with the tools under the responsibility of the logged in user. The user also

have the possibility do some actions related to the tools in the list, edit, view, to perform logging,

to set a service message and to seta general message.

Optional filters for this list  (Hide filters...)

=
A

Tool 1d: Tool name:

Category: — All categories — v Process line: - All process lines -

Deleted tools: Do not show deleted tools ~ Apply filters

Add/remove columns (7 of 36 columns chosen)
Current Messages Name a Tool | Status Bookingtype ist 2nd Allow mail subject
Status id Name resp ibl resp ibl "booking
cancelled"
Edit Book View Log Available General 9301 Available Optional False

Service

Show Page: 1 (Total Records: 1)

%] Records Per Page: 10 «




Tool time blocking
Home » Advanced » Tool responsible » Tool time blocking

The page for tool time blocking enables the tool responsible to block bookings on a tool during
certain times.

Block booking intervalls on tool

Select tool: 104, Ellipsometer - Sagax Iscoscope v Sort: id v

Show: - Show current blockings - + Add/Edit Blocking 1

Add new blocking for Ellipsometer - Sagax Iscoscope

Ridfiemave Golins G oF 10 diimns thasany Add/Edit blocking for tool: Ellipsometer - Sagax Iscoscope (104)

Choose period
Start 2010-10-05 7

Stop 2010-12-31 %
Choose Time
Start 10:00 ~

Stop 17:00 ~
Choose Days

Mon ¥/Tue [VIWed V|Thu [VIFri Sat | |Sun
Choose time before release

Hours 4

Reason for block.

To stop too many
bookings in advance

Save Blocking } ‘ Delete Blocking

Choose period
Specifies a time period during which the specified blocking will be active.

Choose time
Specifies a time during the day when the tool is blocked from being booked.

Choose days
Specifies the days in the week when the blocking is active.

Choose time before release
Specifies how many hours before the specified time the booking block will be released.

An example

As seen in the picture above.

The tool responsible has created a new blocking for a tool during

the period 2010-10-05 to 2010-12-31.

During that time the tool cannot be booked in advance during 10:00 to 17:00 on Tuesdays,
Wednesdays, Thursdays and Fridays. These days users will be able to make bookings between 10:00
to 17:00 from 06:00 (4 hours before 10:00).

Tool blocking does not apply to tool responsible, administrators and members of the service project.

They can book at any time.



Allow/Disallow mail subject "booking cancelled”
Home » Advanced » Tool responsible » Allow/Disallow mail subject "booking cancelled"

When a booking is cancelled it is possible to send a mail with the subject “booking cancelled”.

The list enables the tool responsible to allow or disallow mail with the subject “booking cancelled”
when a booking has been cancelled. Toggle between enabling and disabling this feature by clicking
True/False in the “Allow” column.

Allow /Disallow mail subject "booking cancelled”

-- All categories - v

Add/remove columns (5 of 7 columns chosen)
| Allow I Name a I Tool Id l Status 1st responsible 2nd responsible
True 1 test 2345 Available

True 4-point probe - CMT-SR2000N 103 Available

True Aligning and Assembling Machine 509 Available

True Buffing machine 507 Avzilable

False Chemical preparation -Acid 1309 Available

True Chemical preparation-Sclvent 1302 Available s “ervo e . . > o
True Cleaning-solvents 1002 Available :

True CNT CVD 440 Available - S

True Critical Point Dryer 1170 Available

True Developer baths 208 Available . . » -

Licenses by user
Home » Advanced » Tool responsible » Licenses by user

In this page a tool responsible manages licenses for using tools. This is done by selecting user and
adding/removing licenses for different tools.

Manage licences by user

user:  Martin Klarguist I Display licences

Categories - All categories — v Sort lists by: Tool Name v
Available tools Current licences for user
| Check all Add licence(s) | [7] check all Remove licence(s) j
-
IdName Category IdName Category Issued

[F] 2345 1test Device mounting = [7] 103 4-point probe - CMT-SR2000N Metrology 2010-04-12
=] 509 Aligning and Assembling Machine Other processes [7] 597 Buffing machine Other processes 2010-04-08
=] 1309 Chemical preparation -Acid Wet process benches 1002 Cleaning-solvents Wet process benches 2010-04-09
7] 1302 Chemical preparation-Solvent Wet process benches =] 440 CNT CVD Plasma deposition ~ 2010-04-08

1170 Critical Point Dryer Other processes ] 208 Developer baths Wet process benches 2010-04-09
=] 532 Developer baths, Microwave line Wet process benches [ 204 Developer spinner BLE De Wet process benches 2010-05-12

533 Developer baths, Microvave line Wet process benches 621 Electroplating- Acid Wet process benches 2010-04-07

| 220 Developer III/V and nano Wet process benches | 408 Evaporator - Opto Thin film deposition  2010-04-08
[F] 1011 Dicing saw - Disco DAD3350 Saving [7] 9901 Harrys Golvmopp Surface analysis & TEM2010-05-12

1008 Dicing saw - Loadpoint Microace 3+ Saving [7] 123 Parameter Analyzer - Keithley 4200- Metrology 2010-05-12

= scs

[7] 264 EBL - JEOL JEX-3DII Lithegraphy 230 Surface profiler, stylus - Tencor Metrology 2010-03-30
] 217 EBL - JEOL JBX-9300FS Lithography A3500
[7] 510 Vacuum package Other processes 2007-07-09

= 112 Ellipsometer - J.A. Woollam M2000 Metrology



Licenses by tool
Home » Advanced » Tool responsible » Licenses by tool

In this page a tool responsible manages licenses for using tools. This is done by selecting a tool and
adding/removing licenses for different users.

Manage licences by tool

Optional filters for this list  (Hide filters...) &

Tool: 102____ Microscope - Olympus AH3 (Vanox) v Sort: id v

;fggg?fory/ - All laboratories / groups - v f;;;;;’rgj;t:ed No ~

User role: - All active users of the system — v Sort lists by: First name ~

— Select Tool — -
Available users Current licences for 102 Microscope - Olympus AH3 (Vanox

[Tl check all [Tl check all [ Remove licence(s) ]

Name Lab/Group : Name Lab/Group Issued
] Abdelrahim Ahmed Atomic Physics = ’ Karin Hedsten Nanofabrication Laboratory 2007-07-01
IF fAhmed Eltzhir Elsharif Physical Electronics and Photonics 71 Kenneth Ugochukwu Chibueze Atomic Physics 2010-04-12
:" Aik Yean Tang ProjMngr Physical Electronics Laboratory ‘;A Mohammad Hadi Tavakoli Dastjerdi Microwave Electronics Laboratory 2010-04-12
J;1 Alar Tool R Ainla BioNano Systems Laboratory ‘:“' Mohammed Mahbubur Rahman Physical Electronics and Photonics 2010-04-12
1i Aldo Instr Jesorka Physical Chemistry [ t Peter Modh Nanofabrication Laboratory 2007-07-01
I fAIex Meyer Imego AB 11‘1 Samuel Antonio Rosas Meléndez Quantum Device Physics Laboratory2010-04-12
“* Alexander Dmitriev Bionanophotonics ‘;A Sebastian Johansson-Mauricio Quantum Device Physics Laboratory2010-04-12
[ Alexander Tzalenchuk MC2Access . Vijaya Madhavareddy Daggumati BioNano Systems Laboratory 2010-04-12

Alexandra Nafari Nanofactory Instruments AB [ all Asa Haglund Photonics Laboratory 2007-07-01

Manage Licence applications
Home » Advanced » Tool responsible » Manage Licence applications

The first page shown displays applications from users applying for tool “driving” licenses. By clicking
“Process” the user can manage individual license applications.

Manage Licence applications

Optional filters for this list  (Hide filters...) [&]

Tools: - All Tools - v Active applications v Apply filters

Show only applications on my tools

@ Show applications on all tools

Add/remove columns (6 of 20 columns chosen)

’ D First name o | Last name | User category | Tool name Status | Reason
{J Process Aldo Instr Jesorka Phd Student X-ray Diffractometer New application
D Process Martin Klarqvist Engineer Ellipsometer - Sagax Iscoscope New application
[:\ Process Martin Klargvist Engineer Newton vagga New application
1_‘] Process Martin Klargvist Engineer Photolithography Stepper - ASML PAS 2500 New application
D Process Martin Klargvist Engineer Photolithography Stepper - ASML PAS 2500 New application
D Process Martin Klargvist Engineer Photolithography Stepper - ASML PAS 2500 New application
I'J Process Martin Klargvist Engineer Microscope - Olympus AH3 (Vanox) New application
D Process Martin Klargvist Engineer Ellipsometer - J.A. Woollam M2000 New application

Show Page: 1 (Total Records: 8) [®] Records Per Page: 10




The tool responsible manages the license application as seen below. The application can be declined,
saved as pending and confirmed. There are also some text fields so that the tool responsible can
supply the application with supplementary information about the tool and its intended use.

As soon as the application is confirmed the user can book that specific tool.

Information about the user is also displayed.

Tool
Application date
Status

Application info

Ellipsometer - Sagax Iscoscope(104)
2010-06-07
New application

Prefered date(s)

Estimated use
Practical coach

Short info of intended use

Latest change, by

Decline

Notes

| Save aspending || Confirm licence

(204) Developer spinner BLE De
(93901) Harrys Golvmopp

Current Licences

20100512
20100512

(123) Parameter Analyzer - Keithley 4... 20100512

(103) 4-nnint nrnhe - CMT-SR20NNON

2n10n4ai12

Name
Email:
Phone:
Mobile phone:

University /
Company:
Department:
Laboratory / Groug
Supervisor:

User Category:

- Nanofabrication L
- Service Project

- M2 - Helsinki

- M17 - Athens

- M18 - Bologna

- M27 - Ankara

- M31- Louvain la I
- M32 - Bellaterra-,
- M35-Warsaw

- M37-Karlsruhe

- M38-Trondheim

- M39-UC Leuwen
- M40-Bellaterra

- M41-Prague

- M42-Athens

Bookings, nr of
bookings:

Bookings, total tim

Logs, nr of logs:



Manage instructors by user
Home » Advanced » Tool responsible » Instructors by user

This page is used to add/remove users as tool instructors. This is done by selecting user and adding
tool to that user.

The first page shown displays only a search field. Type/Select the name of the user who is going to be
an instructor. Display the user’s tools by clicking the button “Display Tools”.

Manage instructors by user

Select instructor: Requuredl Display tools |

The tools available for that user are displayed as shown below.
Add the user as instructor by selecting tools in the list named “Available Tools” and click the “Add
tool(s)” button.

Manage instructors by user

Select instructor: ~ Martin Klarquist |_Display tools |
Categories - All categories — - Sort lists by: Tool Name -
Available tools Current tools for instructor
Check all Add tool(s) | Checkall | Removetool(s) |

7 514 Evaporator - Balzers System BAK&00 Thin film deposition -

& NameToolld Category Issued

7 425 Evaporator - Edwards HPTS Thin film deposition i 440 CNT CVD Plasma deposition 2010-10-07

520 Evaporator - Hobbykit Thin film deposition 208 Developer baths Wet process benches 2010-10-07

434 Evaporator - Lesker Spectros Thin film deposition | 220 Developer III/V and nano  Wet process benches 2010-10-07
408 Evaporator - Opto Thin film deposition 1011 Dicing saw - Disco DAD3350 Sawing 2010-10-07
421 Evaporator - Specs EBE-4 Thin film deposition

406 Evaporator - Varian VT 118 UHV Thin film deposition



Manage instructors by tool
Home » Advanced » Tool responsible » Instructors by tool

This page is used to add/remove users as tool instructors. This is done by selecting tool and adding
users as instructors too that tool.

When selecting a tool a list of available users is displayed, just select and add/remove users as
instructors in that list.

Manage instructors by tool

Optional filters for this list  (Hide filters...)

Bl

Tool: 106 Microscope - Olympus MX40 v Sort: id v

Laboratory / iaai] Show deleted

SEaUnEs - All laboratories / groups - ¥ lab/groups: No ~
Sort lists by: First name ~

Available users Current instructors for 106 Microscope - Olympus
MX40
Check all | Add instructor(s) | [Tl check all Remove instructor(s) ‘
Name Lab/Group Name Lab/Group Issued
7 Nanofabrication Laboratory Physical Chemistry 2010-10-07

Nanofabrication Laboratory

Edit log fields
Home » Advanced » Tool responsible » Log fields

This page is used for add/remove/edit additional log fields for a specific tool.
Every tool has three standard log fields; these fields cannot be changed or removed from a tool.

The standard log fields are: “Log start” (Date and time), “Log stop” (Date and time) and “Additional
info” (Text).

To add additional log fields, start by selecting a tool.
Current additional log fields are displayed as shown below.
Add new log field by clicking the button “Add new log field”.
Edit existing log fields by clicking “Edit” in the list.

Edit log fields

Select tool:
. . Common log fields
103 4-point probe - CMT-SR2000N v Sort: id v
Log start (Date and time) Required
Log stop (Date and time) Required
Additional info (Text) Optional
Tool specific loq fields
Log field Type Input by Used since Usage, Average value last 30 Latest value (during last 30
name user % days days)
Edit Rotation Number Compulsory [not impl. 100 8 12 (2010-09-09)
speed yet]

[ Add new log field ‘




It is possible to add additional 9 numeric log fields and 9 additional text log fields.
The fields can be set to Optional, Optional - but warning if not filled on and Compulsory.

Edit log fields
Select tool:
: ; Common log fields
103 4-point probe - CMT-SR2000N v Sort: id v

Log start (Date and time) Required
Log stop (Date and time) Required
Additional info (Text) Optional

Add new log field

Note 1: Be sure to specify the unit of measure as part of the log field name if that is needed.
Note 2: It is not possible to change 'Type of field' once you have added the new log field so choose carefully.

Log field name: Temperature

Type of field: Number (9 more log fields of this type possible to add for this tool) ~

Input by user: - Select input by user — |~

: input by user — i ‘
Optional —J
Optional, but warning if not filled in
\Compulsory lific log fields

Log field Type Input by Used since Usage, Average value last 30 Latest value (during last 20

name user % days days)

Edit Rotation Number Compulsory [not impl. 100 8 12 (2010-09-09)
speed yet]
Add new log field

Maintenance log fields
Home » Advanced » Tool responsible » Maintenance log fields

The functionality is the same as in “Log fields”. See the section “Home » Advanced » Tool Responsible
» Log fields” for more information.

The only difference is that these custom fields only are available in maintenance projects.

Service log fields
Home » Advanced » Tool responsible » Service log fields

The functionality is the same as in “Log fields”. See the section “Home » Advanced » Tool Responsible
» Log fields” for more information.

The only difference is that these custom fields only are available in service projects.



Instructor
The Advanced menu for users with the Role “Instructor”.

[hdvonced e |

Instructor » Licences by user
Newsletter Licences by tool
Internal info page Licences applications
Tags »

Tool downtime

Tool history

Licenses by user
Home » Advanced » Instructor » Licenses by user

In this page a tool responsible manages licenses for using tools by selecting user and
adding/removing licenses for different tools.

See the section “Home » Advanced » Tool Responsible » Licenses by user” for more information.

Licenses by tool
Home » Advanced » Tool responsible » Licenses by tool

In this page a tool responsible manages licenses for using tools by selecting a tool and
adding/removing licenses for different users.

See the section “Home » Advanced » Tool Responsible » Licenses by tool” for more information.

Manage Licence applications
Home » Advanced » Tool responsible » Manage Licence applications

The first page shown displays applications from users applying for tool “driving” licenses. By clicking
“Process” the user can manage individual license applications.

See the section “Home » Advanced » Tool Responsible » Licenses applications” for more information.



Manage my projects
The Advanced menu for users with the Role “Project Manager”.

I Advanced -
Manage my projects » Add/Manage project members
Newsletter Project list
Internal info page New project
Taags »

Tool downtime

Tool history

New project
Home » Advanced » Manage my projects » New project

The page enables a project manager to create a new project.
Add/Edit Project

Project 1d: =

Project name: B

Laboratory / Group:  AlfaExx AB v
Charge type: Zero v

Project leader: Type to see suggestion (min. 3 characters)| =
Type of project: Normal v

Start date: ER =

End date: R =

Supplementary info: A

Is deleted: @) Yes @ No



Add/Manage project members
Home » Advanced » Manage my projects » Add/Manage project members

In this page the project managers can Add/Remove project members. This is done by checking users
and pressing the “Add” button or the “Remove” button.

Add/Manage project members

Optional filters for this list  (Hide filters...) &l
Project Name: 224211 EU Visit (5920416) »
Laboratory / Show deleted
S - All except MyFab lab/groups - - Tabyaroups: No ~
User role: - Al active users of the system - v Sort lists by: First name ~

Available users

[l check all Add [ check all Remove

Name Lab/Group Name Lab/Group
[T - w - Atomic Physics | . - Photonics Laboratory
l"‘ - . - Physical Electronics and Photonics ] - - - Photonics Laboratory
F Physical Electronics Laboratory & . - Photonics Laboratory
D BioNano Systems Laboratory
[] - . Physical Chemistry
D - .- - Imego AB
&l - - Bionanophotonics
5 - - MC2Access
Add/Manage project list
Home » Advanced » Manage my projects » Project list
The page displays the projects registered in LIMS.
Project list
Optional filters for this list  (Hide filters...) &
'éargfl;a,tory 4 Al laboratory / groups v Charge type: — All charge types — v
Project leader: - All project responsibles - Active / deleted:  Show all active i
Add/remove columns (6 of 19 columns chosen)
| l Project Id l Project name & Project leader Start date | End date Supplementary info
Edit 5920416 224211 EU Visit 2008-07-01 2011-06-30
Edit 5920415 224259 EU Subtune 2008-07-01 2011-06-30
Edit 1304 Acreo 2007-09-07 2008-12-31
Edit 69 Atomic Physics 2002-01-01 2008-07-31
Edit 594126 BioNano MC2 2007-11-01 2019-12-31
Edit 122 Biollano Systems 2002-01-01 2009-12-31
Laboratory
Edit 71 Cellectricon AB 2002-01-01 2008-12-31
Edit 72 Chemical Physics 2002-01-01 2008-12-31
Edit 112 Condensed Matter Physics 2002-01-01 2010-12-31

cdi 12ns Cmirmurbale Tee AAAT_A1-AYT  DANG-1D-D1



As shown below, users can send message to the project leader by clicking a name in the “Project
leader” column.

& Send message - Windows lnteme...l | () |

Message to

E-mail:

Phone:

University/Company: Chalmers Univarsity of
Tachnolozy

Laboratory: Photonics Laboratory

Subject

Message

[Send |

As shown below, administrators and project managers can edit a project by clicking the “Edit”

column.
Add/Edit Project
Project Id: 5920416
Project name: 224211 EU Visit
Laboratory/Group: Photonics Laboratory Change
Charge type: Zero Change
Project leader:
Type of project: Normal v
Start date: 2008-07-01 S =
End date: 2011-06-30 3 -

Supplementary info:

Is deleted: ) Yes @ No

Update || Cancel |

To delete a project simply set the radio button “Is deleted” to true.



Administrator
The Advanced menu for users with the role “Administrator”. As shown below, user with the

administrator role have access to all sections.

| Advanced L
Tool responsible 4
Instructor »
Manage my projects 4
Newsletter

Internal info page
Tags >
Tool downtime

Tool history

Common menu sections

There are 5 sections in the “Advanced” menu that are accessible by all roles that have permissions in
the “Advanced” menu. These sections can be accessed by users with the roles of Instructor, Tool
Responsible, Project Manager and Administrator.

Although these roles have permission to the different areas, the do not have the same level of access

to all parts.

As seen below the sections that are accessible to all roles with permission to the “Advanced” menu
is: Newsletter, Internal info page, Tool downtime and Tool history.

I Advanced ! =t

Newsletter

Internal info page

Tool downtime

Tool history



Newsletter
Home » Advanced » Newsletter

Newsletters are sent to all registered users. The newsletter is also sent to all external receivers that
are registered in the “External mail receiver list”.

The “External mail receiver list” is managed by an administrator and can be found at Home » Admin »
System info » External receivers.

There are 4 parts in the newsletter.

- General news — Anything goes here.

Incidents — Reports about incidents in the lab.
- Service and Maintenance - Information about service and maintenance in the lab.
- News/Info about a specific tool.

See picture below.

Newsletter

Current newsletter

E Add news content for tool: - Select tool - v Sort: id v
[ Preview J [ Post newsletter! |
I I Area l Message Added by | ChangedBy
Edit General News E-mail addresses We urge all users to update their e-mail address

in LIMS since Chalmers vill remove the support for all sub-domains
(such as @mc2.chalmers.se) from 1/7. Remember that you have
to ...

Edit Incidents [no content yet]

Edit Service and [no content yet]
Maintenance

Edit Tool #104 - Something is very nice about this tool, like it alot.
Ellipsometer - Sagax
Iscoscope

Edit Tool #114 - Surface
profiler, optical - Wyko
NT 1100

Previous newsletters

The two rows in the bottom are news about specific tools.
Permissions:

- An administrator is allowed to edit all parts of the newsletter.
- Only an administrator is allowed to post the newsletter.

- Atool responsible is allowed to add/edit news content about tools where the user is 1% or
2" tool responsible.

- Auser with the role “tool responsible” is just allowed to view news content about any other
tool.

- Aninstructor is only allowed to view news content about the tool(s).

- A project manager is only allowed to view news content about the tool(s).



To edit the different parts of the newsletter simply click “Edit” on that specific row/part.
Select a tool in the drop down to add news content about that specific tool.

To send the newsletter simply click the button “Post newsletter”, this can only be performed by an
administrator.

Internal Info Page
Home » Advanced » Internal Info Page

In this page the users can manage the content of the internal info page.

The internal info page is the start page for LIMS.

After a successful login the user will be directed to the start/home page which displays the
information entered for the internal info page along with information about the user’s bookings.
Usually the information is about the latest changes and updates.

Editing of the internal info page supports formatting and adding pictures, se picture below.

Internal info page

i EKala | g 5 E B Hm@m g
i Teckenformat | Nomal v Typsnitt Tahoma v | Storlek - 'H'.

1M @ B B = @ ,ra\ig‘i

m

During the summer LIMS was updated with some new functionalities for all users:
Licence application form

When you need to apply for a licence you now have to use the application form found in LIMS. In a
Tool View you find a link to the web form in the Status and Tool description. You will also find the
web form under Tools/Apply for licence. With this web based application we aim to make the

wihnla nrocace emanthar and mara afficiant with raducad numhar of ile and auactinne tn varific

The start page with the updated text and picture is shown below.

iThere are 8 licence applications to processf
{There are 3 user applications to  process

Important information about the lab Booked tools

New LIMS functionalities

3]

My bookings  (Hide bookings...)

JEe

From today and newer v Show not completed log v Hide log status +
Logs without booking  (Hide logs...) A
From yesterday and newer ~ Show not completed
Project leader bookings  (Show bookings...) 9]

During the summer LIMS was updated with some new

functionalities for all users:
Human resource

Licence application form Book Martin Klarqvist

When you need to apply for a licence you now have to _My licenced tools

use the application form found in LIMS. In a Tool View "

you find a link to the web form in the Status and Tool Book View teg. .4pointprobe. CMT.SR2000N/(103)
description. You will also find the web form under Book View Lo  Evaporstor-\0nt0.(408)

Tools/Apply for licence. With this web based Book View Log Harrys Golvmopp (9901)

application we aim to make the whole process Book View Leg Parameter Analyzer - Keithley 4200-SCS (123)

smoother and more efficient with reduced number of [All licenced tools]



Tool downtime
Home » Advanced » Tool downtime

This page displays a list of the tool downtime during selected period, and how many hours the tool
has not been available for booking.

_All tools_
Optional filters for this list  (Hide filters...) &
Period: 2010 v Year: 2010 v
Tool: - All tools - v Sort:id v
Export to Excel...
Add/remove columns (6 of 8 columns chosen)
| Tool Id | ToolName Service time | Maintenance time | Down time | Warning time | Availability (%) |
103 4-point probe - CMT-SR2000N 6.0 0.0 408,4 168,3 94,8
112 Ellipsometer - J.A. Woollam M2000 0,0 0.0 0.0 1,0 100,0
105 Ellipsometer - Rudolph AutoEL-II 0.0 0.0 5 344,1 0.0 33,3
104 i - Sagax L e 0.0 0,0 0,1 1.0 100,0
118 Macro photo system 0.0 0,0 0,0 1.0 100,0
102 Microscope - Olympus AH3 (Vanox) 0,0 0.0 42,9 143,8 93,5
106 Microscope - Olympus MX40 0.0 0.0 0.0 1,0 100,0
126 Microscope stereo - Olympus SZH-10 0.0 0.0 0.0 1.0 100,0
140 Offline analysis(SPM/Ellipsometry/L-draw/AutoCAD 0.0 0.0 0.0 1,0 100,0
229 Ozone Cleaning System FHR UVOH 150 0.0 0.0 0,0 0,0 100,0
130 Ozone Cleaning System Novascan 0.0 0.0 0.0 1.0 100,0
123 Parameter Analyzer - Keithley 4200-5CS 2,0 0,0 0,0 0.0 100,0
110 SEM - JEOL JSM-6301F 0.0 0,0 0,0 1.0 100,0

Click the tool name for details, a popup window will display the details as shown in picture below.

@ Tool downtime data - Windows Internet Explorer - E@@

Data for tool downtime

Tool: Ellipsometer - Rudolph AutoEL-lI
Period: 2010-01-01 - 2010-11-30 I
Type Start date End date Hours
Down 2010-01-01 00:00 2010-08-11 16:04 53441 hour(s)
I Warning 2010-08-21 09:14 2010-08-22 14:10 28,9 hour(s)
Warning 2010-09-24 11:44 2010-08-27 16:50 77,1 hour(s)
Servicetime ime War D
0.0 0,0 106,0 53441 333%
close

Tool History
Home » Advanced » Tool history

This page displays warnings, services and downtimes for a selected tool during for a specific year, or
part of a year. The list displayed is very similar to the one displayed in the popup detail window in
Tool downtime. See picture below.

All tools
Optional filters for this list  (Hide filters...) &
Period: 2010 v Year: 2010 >
Tool: 103 4-point probe - CMT-SR2000N ~ Sort:id v
Export to Excel...
I Tool Id l Tool name [ Event 1Start Stop Timespan l Info
103 4-point probe - CMT-SR2000N Warning 2010-08-05 15:57 2010-08-11 16:04 6d Oh 6min Warning message:
Fett p3 linsen
103 4-point probe - CMT-SR2000N Warning 2010-08-04 15:44 2010-08-05 15:54 1d Oh Smin Warning message:
asch...
103 4-point probe - CMT-SR2000N Service 2010-06-11 13:30 2010-06-11 15:00 0d 1h 30min  Booking Info:
test3
103 4-point probe - CMT-SR2000N Service 2010-06-11 10:00 2010-06-11 11:00 0d 1h Omin Booking Info:
test2
103 4-point probe - CMT-SR2000N Service 2010-05-17 00:00 2010-05-17 01:30 0d 1h 30min  Booking Info:

103 4-point probe - CMT-SR2000N Service 2010-05-15 08:00 2010-05-15 10:00 0d 2h Omin Booking Info:



Admin

|mml Following pages requires the role “Administrator” to view.

Though, some pages that you can reach from an adminpage, you can

Areas / Rooms 4 also reach from a different part of the system. Ex: “Admin -> Tools”
EAtes 2 > “Tool list” -> “Edit tool”, is also reachable from “Advanced” -> “Tool
Jonis 2 responsible” -> “My Tools” -> “Add tool / Edit tool”
Fares and Charges
Invoices »
Process lines »
Project »
Statistics »
System info »
Tags »
User 4
Add

Here you can add new entities. See picture below.

Add... » New university / company
Areas / Roocms » New department
Entities » New laboratory / group
Tools » New project

Fares and Charges New user

Invoices » New tool

Process lines » New area / rcom
Project » New process line
Statistics »

System info »

Tags 4

User »

All entities are handled in separate menus.

Entities

“University / company”, “Department”, “Laboratory / group” have dependencies.

One university can have one or several departments. One department can have one or several
laboratories / groups.

A laboratory / group have to belong to a department, and a department must belong to a university /
company.

Each entity has a page for listing, and one page for add / edit.



Add / Edit University or Company
Home » Admin » Entities » New university /

Name: o

Address: 0

Country: Sweden E]
Type: Commercial E]

Charge type: | High E]

Web page:

VAT:

Is deleted: Yes @ o

| Add || Cancel l

company
Name and VAT are mandatory fields.

Type
Organization type, values are “Commercial”, “University” or “Institute”.

Charge type
Can be “Zero”, “Low”, “Medium”, “High”

This is to set the cost for bookings for people belonging to this type.

Add / Edit Department
Home » Admin » Entities » Add department

University / Company: | Chalmers University of Technology [+
Name:
Address:

Supplementary Info:

Is deleted: 7 Yes @ No

Add || Cancel |

Only “Name” is mandatory.
Choose a university / company to connect the department to.



Add/Edit Laboratory or Group
Home » Admin » Entities » New laboratory / group

Department: Chalmers Industriteknik k2
Name:
Address: -

Cost center:

Supplementary Info: 3

Is deleted: ' Yes @ No

IEI [ Cancel

Only “Name” is mandatory.
Choose a department to connect the Lab / group with.

Laboratory / group are used at many places within the system. It tells belonging of a user,
responsible group for a tool or group, and used for calculate invoices.

Area / Rooms

Area / rooms are as the name suggests physical locations within the lab, which is set for equipment
when you add it in the system. You can temporary close an area, which will prohibit booking on
equipment in that area during the period.

Area / room list
Home » Admin » Areas / Rooms » Area / room list

Optional filters for this list  (Hide filters...)

Responsible: - All room responsibles —- El

Add/remove columns (3 of 5 columns chosen)

l | Name | Area A Room responsible Supplementary info
Edit Saw room Peter Modh
Edit MBE-Lab Peter Modh
Edit [Not defined] 0 MigrationUser MigrationUser Area/room created for
Edit Processlab 2 240 Peter Modh
Edit Processlab 1 1000 Peter Modh

| Show Page: 1 (Total Records: 5)

Add New |




Add / edit: area / room
Home » Admin » Areas / Rooms » New area / room

Room responsible: Peter Modh *
Name: Processlab 1

Area (m?): 1000

Supplementary info: -

“Room responsible” and “Name” are mandatory

Area closedowns
Home » Admin » Areas / Rooms » Area closedown

Area closedowns

Optional filters for this list  (Hide filters...)

Area / Room: - All areas/rooms — [Z]
Period: 2010[~] Year 2010 [+]

Add/remove columns (4 of 8 columns chosen)

| | Area/room a l Closed from Closed to

l Timespan (hours)

Edit Processlab 1 2010-06-08 08:00 2010-06-09 08:00

24

| Show Page: 1 (Total Records: 1)

E] Records Per Page: 10E| |




Add/Edit: Area closedown
Home » Admin » Areas / Rooms » New area closedown

Area Room: Processlab 1 E]
From Time: 2010-06-08 08:00
To Time: 2010-06-09 08:00

Closedown Reason: e will install a new pump for DI water, and -

change some leaking air-pipes

Update || Cancel

“Reason” is optional — rest is mandatory.

“To Time” must occur after “From Time”

During the period, no one will be able to book on equipment standing in that area.

If there are any current bookings, they will be removed when you add the “closedown”, so be
careful.

Booking view during closedown

UayUIne i g s v

General

Aug Sep Oct Nov Dec
8[19]20]21]22]23]24]25]26] 27]28]29]30]31]| | Booking rules

Fri 08/10 Sat 09/10 Sun 10110 1. Min booking time: 30 minutes
" PN
P Jat f :.:ax zootfng zlme, “‘a):tltme. 1100h:urs
Shutdown 3. Max booking |m§, nighttime ours
4. Future booking time, day time: 20 of 20 hours left
S. Future booking time, night time: [No limit]
Meddelande fran webbsida l&

This part of the lab has been shutdown temporary.
!}, We will install a new pump for DI water, and change some leaking
air-pipes

| Processiab Close this window
| Shutdown

Shutdown




Tools

Tool list
Home » Admin » Tools » Tool list

Tool list
Optional filters for this list  (Hide filters...) A
Tool Id: Tool name:
Category: — All categories — E} Status: - All - |Z|
Responsible: -- All tool responsibles - E| Booking Type: -- All booking types --E|
Deleted tools: Do not show deleted tools B Apply filters

Add/remove columns (3 of 44 columns chosen)

Tool name Tool Id & I Manufacturer
View Edit Microscope - Olympus AH3 (Vanox) 102 Olympus
View Edit 4-point probe - CMT-SR2000N 103 Doktor Snuggles
View Edit Ellipsometer - Sagax Iscoscope 104 Sagax
View Edit Microscope - Olympus MX40 106 o
View Edit Surface profiler, stylus - Tencor P15 108
View Edit SEM - JEOL JSM-6301F 110 JEOL Ltd.
View Edit SPM - DI Dimension 3000 SPM 111
View Edit Ellipsometer - J.A. Woollam M2000 112 J.A. Wollam
View Edit Surface profiler, optical - Wyko NT 1100 114 Wyko
View Edit SEM - Zeiss Supra 60 VP (IXRF EDX) i16 Zeiss
View Edit  Macro photo system 118
View Edit X-ray Diffractometer 120 Philips
View Edit Parameter Analyzer - Keithley 4200-SCS 123 Keithley
View Edit  Microscope - Olympus MX50 125
View Edit Microscope stereo - Olympus SZH-10 126
View Edit IR Wafer Inspection System 127
View Edit Ozone Cleaning System Novascan 130 Novascan
Viaw Edit Offlina 2as lusizl GDMIEllinsamatnd | -Araud Aubaran 1an uo

It is possible to view a tool or edit a tool from the list.

Fares and charges
Home » Admin » Fares and Charges

Fares and charges can be split up in “Hourly rates”, “Monthly fee” and “Monthly fee reduction”
Each rate/fee is showed as a matrix, and this is the values used for calculate invoices.

All fees have a period for which they are valid, and often you only set this once.

Hourly rates

Hourly Rates (current) Previous hourly rates
[Change hourly rates]

Start month I End month
Tool rate/Charge type Low Medium High 200208 200703
A 100 SEK 200 SEK 300 SEK 200710 :
B 300 SEK 500 SEK 600 SEK
C 500 SEK 800 SEK 1000 SEK
D 800 SEK 1300 SEK 1600 SEK
E 2000 SEK 3000 SEK 4000 SEK

Hourly rates are for calculating cost of a booking per hour, combining the Tool rate and the Charge
type of project. (?)



Monthly fee

Monthly fee from 200710 and forward Previous fees
[Change fees]
Start month | End month
Low Medium High 200001 200709
Monthly fee, SEK 1000 SEK 1500 SEK 2000 SEK 200710 _
Monthly breakpoint, 10000 SEK 15000 SEK 25000 SEK
SEK
Reduction after 0% 70% 60%

breakpoint, %

Monthly fee is for calculating the cost of members in a certain lab group.

Monthly fee reduction

Monthly fee reduction from 200710 and forward Previous restrictions
[Change reduction]

Start month End month
Area type Reduction 200208 200709
No restriction 0% 200710
Only coat lab 0%
Only clean lab 0%

Users with access to only parts of the lab can have a reduction of monthly fee.

Invoices
Invoices are being calculated by a lot of factors, by combining monthly fee, hour rate, booked or
logged time.

This section covers generation of invoices, displaying invoices based on different parameters, and
simulation of invoices.

Price levels and invoice functions as implemented in LIMS

Below follows a short description of how price levels are set and how invoices can be calculated using
the Myfab LIMS system. There are several possibilities to calculate costs under "Admin" and
"Invoices". It is also possible to sort the costs in various ways by choosing clicking on the headers. The
main entity for handling costs is "Project" so it is important that projects and project members are

correctly set-up before using the invoice functions.

Charge type

In LIMS, it is possible to assign three different "Charge types". The three levels are called "Low",
"Medium" and "High". The intenteded use for "Charge type" is to have a possibility to set different
price levels for different categories of users. It is thus possible to set lower rates for academia and
higher rates for commercial users. The charge type "Medium" can be used if a middle price level is
wanted.

However, it is not necessary to use all three charge types. If all users should pay the same rates, this
can be achieved by always assigning the same charge type (e.g. Low). The charge type can be
assigned to "University/Company" and to "Project". Normally, a user will only work on projects that
belong to the user’s University/Company. Then the charge type of the University/Company and the
Project will be the same.



However, it is possible for a user to book some time on an academic project (usually charge type
"Low") and some time on a commercial project (usually charge type "High").

Tools
All tools must have an assigned "Tool rate". Five different rates are possible to set:

A, B, C, D or E. The rate is the hourly cost in SEK/hour. Rate A is the lowest, rate E is the highest.
However, it is not necessary to use all five levels. If it is wanted that all tools should have the same
price, this can be achieved by assigning the same rate (e.g. rate A) to all tools.

The tool rate is set using "Edit" in the tool list. The actual rate value in SEK/hour is set on the page

"Fares and Charges". For each of the three "Charge types", a value for the tool rate should be set.

This means that the matrix for hourly costs will consist of (A,B,C,D,E) x (Low, Medium, High) which
gives 5 x 3 = 15 values.

The hourly cost set by the tool rate can apply to "Booked hours" or to "Logged hours". The choice is
made under "Invoice settings" on the "System settings" page.

Please note that tools with "Compulsory booking" will always result in a cost when invoice
calculation is done. Tools with "Optional booking" will result in a cost only if a booking was made.
Tools which are "Unbookable" will not result in a cost.

Monthly fee

In LIMS, it is possible to set a monthly fee for the users. The monthly fee is calculated on a calendar
month basis. This cost is fixed and will not be influenced by the number of booked or logged hours.
The fixed cost is intended to cover such things as cleanroom clothing, use of tools that are not
booked (e.g. microscopes, wet benches and similar) and administration costs. Alternatively, the
monthly fee can be used if a lab wants to charge only by a fixed monthly fee. The hourly rates
mentioned above should then be set to zero.

A setting under "Invoice settings" on the "System settings" page allows a lab to choose between
applying the monthly fee to all "Active users" without regard to any booking or logging that month
or applying the monthly fee only to active users that have at least made one booking/logging during
the month.

If the setting is chosen to always apply a monthly fee to active users and a user do not have any
booked or logged time for a month, the University/Company that the user belongs to will be charged
the monthly fee. In the invoice generation this will be accomplished by creating a special project
named "<Name of Laboratory/Group> - Monthly Fees". The monthly cost for users with no booked
or logged hours will be charged to this project.

The monthly fee can have three different levels (Low, Medium, High) as described under "Charge
type". The level for a specific user is determined by the charge type of the University/Company that
the user belongs to. The actual cost in SEK/month is set on the page "Fares and Charges".



The monthly fee for each user is divided equally amongst the university/companies that own the
projects that the user has booked or logged time on for the given month. The cost will then be
divided amongst the projects.

As an example: User A has booked time on Projectl, Project 2 and Project 3 for one month.

He has a monthly fee of 1200 SEK. Project 1 and Project 2 belongs to University/Company XX and
Project 3 belongs to University/Company YY. Since both Project 1 and Project 2 belongs to same
University/Company the monthly fee will be divided as follows:

Project 1: 300 SEK
Project 2: 300 SEK
Project 3: 600 SEK

Fee reduction based on booked or logged hours

In LIMS, it is possible to apply a discount for users with many hours during a month. The discount is
calculated by adding all hourly costs for an individual user during a calendar month. A reduction in
percent is given on hourly costs above a specified breakpoint.

The actual value in SEK for the breakpoint and the percentage of the reduction is set on the page
"Fares and Charges".

Only hours for projects that belong to the same University/Company and have the same charge type
are basis for the fee reduction. If a user book or log time on projects belonging to different
Universities/Companies or different charge types, the adding of costs for the discount calculation is
done separately for each (University/Company and/or charge type).

The fixed monthly fee is not included in the calculation of the fee reduction.

Monthly Fee reduction based on user area restriction

It is possible to apply a monthly fee reduction for users that do not have access to all areas of the
laboratory. When editing a user in LIMS the area restriction can be set for that user. On the page
“Fares And Charges” the reduction for each “Area Restriction” is set.

Simulation of invoices.

Note: If the simulation period span over several months, the difference between real and simulated
invoices is not only related to changes done in "Simulate invoices", but also because any real changes
within the simulation period will not have an effect in the simulation because of the initial values for

the simulation origin from the last month in the chosen period.

A suggestion would be to first make a simulation for the same period without any changes at all to
see the effect of no changes.



Invoice by project
Home » Admin » Invoices » Invoice by project

Optional filters for this list  (Hide filters...)

£

© predefined time: 2009[+] Q12009  [+]
) Custom time: v F—{? t 2 ﬂ
University / 2 o =
ESBahg: — All Universities / Companies — B
Note 1: Invoice data are based on booked hours.
Note 2: Hours for each time period are for bookings that end within that period.

Add/remove columns (6 of 13 columns chosen)

Month Project Name Hours v Monthly fees Cost by hours Total cost
2009-03 1256,0 26 000 716 050 742 050
2009-01 1191,0 19 500 634 150 653 650
2009-02 1033,0 22 000 556 850 578 850
2009-03 - 763,5 2025 2025
2009-01 678,0 2427 2427
2009-03 625,5 8 000 369 250 377 250
2008-02 520.0 8 500 306 150 314 650
2008-03 480,0 3 608 3 608
2009-02 453,0 2532 2532
2009-02 278.0 4 031 4031
2008-01 275.0 4 083 4 083
2009-03 260,5 4 000 158 250 162 250
4 000 185 850 189 950

2009-02 258.0

Invoice by tool
Home » Admin » Invoices » Invoice by tool

Optional filters for this list  (Hide filters...)

© predefined time: 2008[~]Oct 2008 [+]
_) Custom time: 22 to: 200 =
Responsible 7
SroD: - All Laboratories / Groups - E]
Tool: 108 Surface profiler, stylus - Tencor P15 E Sort: id E]
Category: - All Categories — E|
Note 1: Invoice data are based on booked hours.
Note 2: Hours for each time period are for bookings that end within that period.

Add/remove columns (8 of 16 columns chosen)

Month a I Toolld l Tool name Tool category | Project Id | Project name I Hours I Cost by hours
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 76 8,0 3830
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 79 2,0
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 102 2.0 1200
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 1136 4,0 1200
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 1209 1,0
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 1210 3.5
2008-10 108 Surface profiler, stylus - Tencor P15 Metrology 16254100 9,0 2700

Invoice by User
Home » Admin » Invoices » Invoice by tool

Optional filters for this list  (Hide filters...)

&

© predefined time: 2008[~| | Oct 2008 [~]
© Custom time: 5) L ﬁ)
University / 7 - =
Company: - All Universities / Companies - E]
Project: _ . E
Cost center: Apply filters
Note 1: Invoice data are based on booked hours.
Note 2: Hours for each time period are for bookings that end within that period.

Add/remove columns (7 of 31 columns chosen)

Month Project name User I Hours | Monthly fees | Cost by hours | Total costw

2008-10 358,0 1000 181 300 182 300
2008-10 241,0 1 000 120 500 121 500
2008-10 185,0 1000 96 650 97 650
2008-10 93,5 1000 79 150 80 150
2008-10 136,5 1 000 73 050 74 050
2008-10 71,5 1000 61 600 62 600
2008-10 44,0 1000 25 000 26 000
2008-10 43,0 1000 24 100 25100
2008-10 49,5 1000 23 550 24 550



Regenerate invoices
Home » Admin » Invoices » Regenerate invoices

Since invoices are calculated, you must regenerate them if you have been changing a previous
booking or logging.

Regenerate invoice data from: 2009-08 to 2010-08 l Ok ’

Select period, and click “Ok” to regenerate the invoices.

Simulate invoices
Home » Admin » Invoices » Simulate invoices

Simulate invoice data

Step 1: Choose the period for which you want to simulate invoices by entering from-month and to-month (YYYYMM).

Step 2: Press button 'Step 2: Initialize values for given period'

Step 3: Go through all lists below and change to desired values. For each textbox or dropdownlist in the lists below the actual real
value (for your chosen to-month) is on the left of that textbox or dropdownlist. If you press enter after you have changed a value in
a textbox the background will be changed for that cell to make it easier to see the changes you have done.

e Step 4: Press button 'Step 4: Start simulation calculation'.

Step 5: Go to any of the other simulation pages to see the result of your simulation.

Step 1: Simulation period (YYYYMM - YYYYMM): | 2010-05[~|- 2010-08[+] | Step 2: Initialize values for given period |

Step 3: Change Hourly rates

and/or Monthly fees
and/or Area restriction reductions = x X
/ l Step 4: Start simulation calculation J

and/or Tool rates

and/or Project charge types

and/or University/Company charge types

Step 3: Change hourly rates [top Step 3: Change mo
Low New rates Medium New rates for | High New rates Low New values
Charge for Low Charge Medium Charge for High Charge for Low

Rate A: 100 100 200 200 300 300 Monthly fee, SEK 1000 1000

Rate B: 300 300 500 500 600 600 Monthly breakpoint, SEK 10000 10000

Rate C: 500 500 800 800 1000 1000 Reduction after breakpoint, % o 0

Rate D: 800 300 1300 1300 1600 1600

Rate E: 2000 2000 3000 3000 4000 4000 [ Update page
Step 3: Change university/company charge types [top] ies SyOptics Hinh High  [+]

1305 Epicrystals Inc High High [+

[ university/company name [ chargeType at period end [ simulated ChargeType 1319 Fingerprint Cards AB High High ;
Chalmers University of Technology  Low Low  |<] e S s o E]
BeIiE ity of Techndlogy Low Low E] 1314 Gratings for Univ. of Barcelona High High [=
Géteborg University Low Low ‘Z] s Taso AR Tk High E]
tind Universty Low Low B 1301 Imego Capacitive Sensor High High  [+]

By changing fares and charges on this page, you can simulate invoices to see what the outcome
would be.

oStep 1: Choose the period for which you want to simulate invoices by entering from-month and to-
month (YYYYMM).

oStep 2: Press button 'Step 2: Initialize values for given period'

*Step 3: Go through all lists below and change to desired values. For each textbox or dropdown list in
the lists below the actual real value (for your chosen to-month) is on the left of that textbox or
dropdown list. If you press enter after you have changed a value in a textbox the background will be
changed for that cell to make it easier to see the changes you have done.

oStep 4: Press button 'Step 4: Start simulation calculation'.

*Step 5: Go to any of the other simulation pages to see the result of your simulation.



Simulated invoice by project
Home » Admin » Invoices » Simulated invoice by project

Optional filters for this list  (Hide filters...) &
Simulation
s 2009-08[] - [2009-10[~]
University / P Py .
Company: -- All Universities / Companies — |Z|

Note: If the simulation period span over several months, the difference between real and simulated invoices is not only related to
changes done in "Simulate invoices", but also because any real changes within the simulation period will not have an effect in the
simulation because the initial values for the simulation origin from the last month in the chosen period.

A suggestion would be to first make a simulation for the same period without any changes at all to see

the effect of no changes.

Add/remove columns (11 of 19 columns chosen)

Month | Cost Project Name Hours | Monthly Cost by Total Diff. Total i
- center fees hours cost cost Total cost by hours Monthly fees
2008- AlfaExx AB - Monthly fees 0.0 2 000 2 000 18 000 20 000 20 000
o8
2009- Analytical Chemistry, GU - 0,0 2000 2000 18 000 20 000 20 000
o8 Monthly fees
2009- Atomic Physics - Monthly fees 0.0 25 000 25 000 225 000 250 000 250 000
o8
2009- Biological Physics - Monthly fees 0,0 13 000 13 000 117 000 130 000 130 000
o8
2009- BioNano Systems Laboratory - 0.0 16 000 16 000 144 000 160 000 160 000
08 Monthly fees
2009- Bionanophotonics - Monthly 0,0 4 000 4 000 36 000 40 000 40 000

Simulated invoice by tool

Home » Admin » Invoices » Simulated invoice by project

Optional filters for this list  (Hide filters...) &

Simulation

=i 2009-08[~] - [2009-10[~]

Responsible -

S - All Laboratories / Groups - |Z|

Tool: — Al tools — [+]/sont:id  [+]

Note: If the simulation period span over several months, the difference between real and simulated invoices is not only related to
changes done in "Simulate invoices", but also because any real changes within the simulation peried will not have an effect in the
simulation because the initial values for the simulation origin from the last month in the chosen period.

A suggestion would be to first make a simulation for the same period without any changes at all to see

the effect of no changes.

Add/remove columns (8 of 20 columns chosen)

Month 4 | ToolId [ Tool name Project name | Hours | Cost by hours | Simulated Cost by hours | Diff. Cost by hours
2009-08 806  MBE-system - EPI 930 Service Project 428,0
2008-08 510  Vacuum package Service Project 11,5
2008-08 510  Vacuum package BioNano MC2 2,0 200 400 200
2009-09 806  MBE-system - EPI 930 Service Project 214,0
2009-10 108 Surface profiler, stylus - Tencor P15 Service Project 3,0
2008-10 408 Evaperator - Opto Service Project 2,0

Simulated invoice by user
Home » Admin » Invoices » Simulated invoice by project

Optional filters for this list  (Hide filters...)

&

Simulation

Sl 2009-08 [~ - 2009-10[~]

gg'r‘:‘ir::%/ — All Universities / Companies — EI

Project: - All Projects — E

Cost center: Apply filters

Note: If the simulation period span over several months, the difference between real and simulated invoices is not only related to
changes done in "Simulate invoices”, but also because any real changes within the simulation period will not have an effect in the

simulation because the initial values for the simulation origin from the last month in the chosen period.
A suggestion would be to first make a simulation for the same period without any changes at all to see
the effect of no changes.

Add/remove columns (9 of 38 columns chosen)

Month a | Project name User [ Monthly fees [ Total cost | Diff. Total cost |
2009-08 ¢ 1 000 1000 5 000
2009-08 I 1000 1000 3 000
2009-08 | 1000 1000 3 000
2005-08 M 1000 1000 s 000
2009-08 | 1000 1000 3 000
2009-08 | - ' 1 000 1000 s 000
2009-08 1 000 1000 5 000



Process line
Tools used in a process flow can be grouped using a process line.

Process line list
Home » Admin » Process lines

| l Name a I Description l
Edit Microwave and Photonics process line
Edit Quantum Device process line

| Show Page: 1 (Total Records: 2) [® Records Per Page: 10 E] I

Add New

Add/Edit Process line
Home » Admin » Process lines » New process line

Name: -| Edit or adding a new process line gives only two options:

Description: R

Name and description, the name is mandatory.

Add Cancel

After you added a process line, you can associate tools to it.

Add/Manage tools for process lines
Home » Admin » Process lines » Add/Manage tools for process line

Process line: Microwave and Photonics process E|

Category: — All Categories — [+] sorts list by: | Tool Id [~]
Available tools Tools in process line

[T check all Add [T check all

| Tool Id Tool Name | & I Tool Id Tool name

[ 102 Microscope - Olympus =| [F] 210 Mask aligner - KS MIB3-UV 400

L’J 103 4-point probe - CMT- ' 407 Sputter - Balzers PLS 550

[F] 104 Ellipsometer - Sagax [F] 531 Ultrasonic bath, Microvave line

[F] 106 Microscope - Olympus [F] 532 Developer baths, Microwave line

[7] to8 Surface profiler, st [7] 3533 Developer baths, Microvave line

J 110 SEM - JEOL JSM-6301F 1g 534 Spinner & HMDS, Microvave line

[ ‘; 111 SPM - Veeco Dimensio [Pl 535 Hot plates, Microvave line

(] 112 Ellipsometer - J.A.

= 114 Qurfara nrafilar An

Select tools that you want to add/remove from the process line.



Project

In order to make a booking, you must associate it to a project.

A user can be member of different projects at the same time. Each project has a start and a stop
date, and outside of this period, it’s not possible to make a booking on the project. Each project does
also have a charge type, for calculating invoices.

Add/Edit projects
Home » Admin » Project » New project
This page is also reached by users with role “Project manager”

Add/Edit Project

Project Id: 556

Project name: Microplating

Laboratory / Group: |Nanofabrication Laboratory E]
Charge type: Medium E]

Project leader: Johan Backlund

Type of project: Normal E}

Start date: 2010-10-01 B3

End date: 2010-12-31 i

Supplementary info:

Is deleted: Yes © No

‘EH Cancel \

All fields but “Supplementary info” are mandatory.

Project Id
This is the Id you choose for the project. This must be a unique number.

Project name
Name of the project

Laboratory / group
Group responsible for the project

Charge type
Zero — Low — Medium — High. This is to set the cost for bookings within this project.

Project leader
Responsible for project

Start date / End date
Dates for start and stop. It’s not possible too book before start or after stop.

Supplementary info
Optional. Short description of project.



When changing charge type or laboratory group, the user must select a start month for the new
charge, since cost is calculated per month

Project list
Home » Admin » Project » Project list
This page is also accessible to users with role “Project manager”

Lists projects — both current and old/deleted, by using the filter.

Project list
Optional filters for this list  (Hide filters...) &
Laboratory / 2
Group: All laboratory / groups E} Charge type: - All charge types --E}
Project leader: -- Al project responsibles - E Active / deleted: | Show all active E
Add/remove columns (6 of 19 columns chosen)
| | Project Id | Project name a | Project leader | Start date | End date Supplementary info
Edit 5920416 i 2008-07-01 2011-06-30
Edit 5920415 2008-07-01 2011-06-30
Edit 1304 2007-09-07 2009-12-31
Edit 69 2002-01-01 200S-07-31
Edit 594126 2007-11-01 2009-12-31 Exjobbare Alar Ainla kér p3 timme fér Zoran
Konkoli, handleds av Aldo Jesorka fysikalisk
kemi
Edit 122 2002-01-01 2009-12-31
Edit 71 2002-01-01 2009-12-31
Edit 72 2002-01-01 2009-12-31

From the list, the user can choose to edit a project.

Add / Manage project members
Home » Admin » Project » Add/Manage project members.
This page is also reached by users with role “project manager” or “project leader”

Add/Manage project members

3y
1

Optional filters for this list  (Hide filters...) &l
Project Name: Senvice Project (123) IZI
Laboratory / Show deleted
Rune — All except MyFab lab/groups - E] B No B
User role: - All active users of the system - E] Sort lists by: First name [+ |

Available users

1 check all [ Add | "1 Check all Remove |

[ Name Lab/Group | [ Name Lab/Group

m

Here, you choose a project to view current members.
You can then choose other available users from the list to the left, and add as member of the project.
Or, choose users from the list to the right to remove from the project.



Statistics

The pages cover statistics for bookings and loggings, seen from different views.

One view is summarization of bookings/loggings, with the option to group by up to three entities —
the other view is to see the actual bookings/loggings in a selected period.

Statistics for booked time
Home » Admin » Statistics » Statistics for booked time

Statistics for booked time

2|

Optional filters for this list  (Hide filters...)

O Predefined time: 2009[~] Q12009  [+]
Custom time: £ B
Note: Booked hours are for all bookings that end within the selected time period.
First entity: University / CompanyB -- All University / Companys - E
Second entity: - Select entity 2 ~E]
Third entity: - Select entity 2 first E|
| Export to Excel |
[ university / company Booked hours

18,5

12 766,5
562,0
206,5
44,5

Total: 13695

This page shows bookings during a specific period of time, grouped by entities.

Using the groups in different order, you can create a very specific report, example:

“How many hours have Person X booked in the Project Y, on Tool Z, during period P?”

Or, like above: “Booked hours, grouped by University/Company, during first quarter of 2009”



Statistics for logged time
Home » Admin » Statistics » Statistics for logged time

This page works the same way as “statistics for booked time” — but displays a summary of the logged,
time instead of the booked time.

Statistics for logged time

Optional filters for this list  (Hide filters...) &
© Predefined time: 2008[~| Year 2008 [~]
5
Custom time: s
Note: Logged hours are for all logs that end within the selected time period.
First entity: University / CompanyB - All University / Companys — E]
Second entity: Department B - All Departments - E]
Third entity: Project B - All Projects —- E]
Export to Excel ]
| University / Company Department Project Logged hours
2,5
2,0
2,0
1,5
202,5
99,0
7.0
12,5
5.5
174,0
4.0
75,0
6.5
178,0
0,5
35,0
9,0
2,0

Total: 818,5

Booking List
Home » Admin » Statistics » Booking list

This page shows all bookings within a certain period of time. Service bookings have the color of
yellow, maintenance orange — but can be filtered not to be visible.

Booking list

)

Optional filters for this list  (Hide filters...)

Tool: 420 Evaporator - AVAC HVC600 El Sort: id E]
Project: Show booked time for all projects E
2829301 2 3
7 8 910 User: Type to see suggestion (min. 3 characters
1213 1415 16 17 [ —
19 20 21 22 23 24 _) Predefined time: 2010 Oct 2010
2627 282930 31| | @) Cuctom time: 20101004 9 to: 2010-10-06 5 | Apply datefiter
Week 1 2 3 4 5 6 7
Display Bookings

Add/remove columns (7 of 30 columns chosen)

\ Edit } Usera LabGroup of user 4 | Tool 1d | Tool name LabGroup of project Timespan | Supplemen

420 Evaporator - AVAC HVC600 20,5

420 Evaporator - AVAC HVC600 2,5

P

420 Evaporator - AVAC HVC600 3

420 Evaporator - AVAC HVC600 1.5

420 Evaporator - AVAC HVC600 1,5

420 Evaporator - AVAC HVC600 3

420 Evaporator - AVAC HVC600 3



Log list
Home » Admin » Statistics » Log list

A page just like booking list — but in this case, all logs during a certain period.

Log list

Optional filters for this list

(Hide filters...)

]

[

oktober 2010 Tool: — Select tool - [+] sotid [+]
Month ma ti on to fr 18 s& Project: Show booked time for all projects [+]
Week 27 2829301 2 3 =
Week 4 5 6 7 8 9 10 User: Ty 1 (min. 3 characters

Week 11 12 13 14 15 16 17
Week 18 19 20 21 22 23 24
Week 25 26 27 28 29 30 31

Week 1 2 3 4 5 6 7

Custom time:

© predefined time:

2009[~] Oct 2009
=

Display Bookings

Add/remove columns (7 of 31 columns chosen)

‘ Edit l Tool name Start |stnp |Tlmespan Supplementary info Batch name [ Completed
ate

Edit Sputter - Balzers PLS 550 2009-10-01 10:00 2009-10-01 12:00 2 Deponering av ca 25004 Si3N4. RWG InGaAs 200S-10-01
QW lasers #2 13:40:09

Edit Mask aligner - KS MJB3-UV 2009-10-02 08:30 2009-10-02 10:30 2 Litografi for 6ppning av SiN vid p-kontakt. RWG InGaAs 2009-10-02
OK., QW lasers #2 12:06:04

Edit Developer III/V and nano 2009-10-02 08:30 2009-10-02 10:30 2 Litografi for 6ppning av SiN vid p-kontakt. RWG InGaAs 2009-10-02
OK. QW lasers #2 12:06:18

Edit Resist spinner III/V and 2009-10-02 08:30 2009-10-02 10:30 2 Litografi for 6ppning av Sil vid p-kontakt. RWG InGaAs 2008-10-02
oK. QW lasers 22 12:06:25

Edit Plasma etch-RIE/CVD - 2009-10-02 10:30 2009-10-02 12:00 1,5 Etsning av SiN. Recept: adolfsson SiN etch RWG InGaAs 2009-10-02
Oxford Plasmalab System QW lasers =2 12:06:52

Project time by resource
Home » Admin » Statistics » Person project hours

Gather all resource bookings for a project or person, during a certain period.
(Hours booked on a project, without booking on a tool)

Project time by resource

Optional filters for this list

(Hide filters...)

51
2

&]
© predefined time: 2010 E] Jan 2010 El
) Custom time: = ®
Projects: — Projects — E]
User: - Users — EI
Add/remove columns (6 of 11 columns chosen)
First and lastName ] Project Name Start a Stop Period Timespan
Martin Klarquist Nanofabrication Laboratory 2010-01-18 2010-01-18 12:00 - 13:30 1.5
Martin Klargvist Service Project 2010-01-18 2010-01-18 1 0 - 14:30 1,0
Martin Klargvist Service Project 2010-01-20 2010-01-20 12:00 - 13:00 1,0
Total: 3,5

ShowPage: 1 (Total Records: 3) [ Records Per Page: [{g E] I




System Info

System settings
Home » Admin » System info » System settings

Most of these settings are made only once, since changing them can create usage problems,
especially when changing something from “allow” to “don’t allow” or the opposite way around.

Settings are.

E-mail settings, Invoice settings, Booking settings and General settings

E-mail settings: These settings are for receivers of mail at certain events in the system.
* When a night shift booking is made
* When a user applies for access

*  When a mail is sent to “system admin”

£-mail Settings

E Receivers when night shift booking is made

E Active E| The users in this list will get a message when a night shift booking is made.

Type to see suggestion (min. 3 characters)| | Add receiver

'['No receivers added]

E Receivers when new user is added

E Active B The users in this list will get a message when a request for membership as user in system is made.

5) | Add receiver |

(min. 3 char

! [Martin Kiarquist

i |UIf Sédervall

. Receivers for mail to Systemadmin

E Active E| The users in this list will get messages when a message is sent to booking system administrator.

Goran Alestig

Invoice settings
Booking settings

Public tool list

General settings



Invoice settings: For generation of invoice data.

E-mail Settings

: Base invoices on:

Booked time ‘z’

5 Tool charge:

f i 'No charge for tool owners' means that if a user does a booking :
! toalicharge;appiies:for.all tools B or log (depending on invoices are based on booked or logged
time) and the project for that booking/log are owned by the
same laboratory / group as the owner of the tool, the project
will not be charged.

| Monthly fees: :
E Always charge monthly fee for active users B If set to 'Always charge monthly fee for active users' all active i
g users will allways pay montly fee, regardless whether the user |

have booked or logged time (depending on invoices are based |
on booked or logged time) for a given month or not. i

Note: If you make any changes to the invoice settings
. above, all invoice data will be re-generated (can take
Sa"ms several minutes) next time someone opens any of the

Booking settings

Public tool list
General settings

Tool charge:

“Tool charge applies for all tools” or “No charge for tool owners”

No charge for tool owners means that if a user does a booking or log (depending on invoices are
based on booked or logged time) and the project for that booking/log are owned by the same
laboratory / group as the owner of the tool, the project will not be charged.

Monthly fees

If set to “Always charge monthly fee for active users” all active users will always pay monthly fee,
regardless whether the user have booked or logged time (depending on invoices are based on
booked or logged time) for a given month or not.

Note: If you make any changes to the invoice settings above, all invoice data will be re-generated
(which can take several minutes) next time someone opens any of the invoice-pages.



Booking settings: These general rules apply to all users of the system.

E-mail Settings

Invoice settings

Booking settings

i | save settings

Public tool list

General settings

' Nightshift start: 18[~] :
i Nightshift stop: 07 E] :
Start view, bookings Show bookings from yesterday and newerE]
Missing log(s) for bookings with mandatory logging: Always allow booking E]
Change log Don't allow to change start time on started log E]
Project leader bookings Show project leader bookings on start page E]
Logs without booking Do not show logs without bookings on start page E]

Nightshift start and stop

In this case, a booking made between 07 and 18 is considered a “daytime booking”, while a booking
between 18 and 07 is a nighttime.

At nighttime, you are not allowed to be alone in the lab — just must have a so called “Lab buddy”.
There can also be a difference in the amount of time you can book for a tool at day or at night.
(Those settings are made at tool-level)

Startview, bookings
Default sorting on startpage, when a user log in.

Values: “Show from yesterday and newer”, “show from today and newer”, “show non logged
bookings”

Missing log(s) for bookings with mandatory logging
You can force the user to log his previous bookings, before he’s allowed to create a new.

Change log
Allow user to change start time on an existing log.

Project leader bookings
Show the list of (if used) project leader bookings on homepage.

Logs without bookings
Show the list of logs with no connected booking.



Public tool list:
Select which columns should be visible in the public tool list — showed for anonymous users.

E-mail Settings
Invoice settings
Booking settings
Public tool list

Save settings

[¥11 st responsible

2 nd responsible

¥ Category

@ Description

[V Manufacturer

VI Model

[VIname

[¥I ool 1d

[“] Area name

| Available

Booking

L | Current toolratetype name
| Footprint

[ Future allocation limit daytime

Cotriva allanabine lmmit minkitioma

General settings: This is general texts — like Laboratory name, Newsletter headers and settings for
what a user can choose when making an application.

E-mail Settings
Invoice settings
Booking settings

Public tool list

General settings

Laboratory-name: Nanofabrication Laboratory 3
Login-header: Welcome to LIMS - Chalmers MC2
Newsletter-mail-header-accidents: Incidents
Newsletter-mail-header-general:  General News

Newsletter-mail-header-service:  Sepice and Maintenance

Area Restriction choise: Let user choose Area restriction when applying E]
Access hours choise: Don' let user choose Access hours when applyingE]

Allowed filetypes for upload: £l
& 58 1.ipg Lot txt | .doc | .xIs | .ppt | -pdf| .gif | .jeg | -png | .mp3

Save settings

Newsletter-mail-subject: Nanofabrication Laboratory Newsletter week [week], [year]



Area restriction choice

Determinates if the user, when creating an application, can choose which part of the lab he wants to
gain access to.

Access hours choice

Determinates if the user, when creating an application, can choose for which times he wants to gain
access to the lab.

External info page

Home » Admin » System info » External info page

This page controls the information published on the start page of the system, for anonymous users.

Using the “what you see is what you get”-editor, you can format and adding text, links and
information.

Kl | &d Q|| B =
Teckenformat | Nomnal - | Typsnitt ~| Storlek MR
B 7 U | i=|es | Fa I ez B OB T S - (I I N7

This system is developed within Myfab and is common to the Nanofabrication Laboratory at Chalmers,
the Electrum Laboratory at KTH and the Angstrém Microstrucure v at Uppsala University.

You can view Tools and Info without logging in. New lab users should apply for access using the
membership form

[sawe ]

Night shift message
Home » Admin » System info » Nightshift message

This is the info showed when you are doing a booking that partly or whole are outside the daytime

perimeters. Using the “what you see is what you get”-editor, you can format and adding text, links
and information.

[Ehowing the latest message. Click "New" to add a new one

[ Ekae | 1|3 <)

‘ Teckenformat ~ | Typsnitt ~ | Storlek v M-

[B 7 U | iE = B=nFeHEEe@N@
Al

To visitthe lab during selected time, you need a special commission, and a verified lab-buddy.
If you don't have a lab-buddy, one will be appointed to you

Do you understand?

[Saw]




External mail receivers
Home » Admin » System info » Add external mil receivers

Add/Edit/Remove mail addresses for users who are not member of LIMS, but should have the
newsletter.

| Firstname a4 | Last name Email

Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit
Delete Edit

I Show Page: 1 (Total Records: 13) [X] Records Per Page: 20 E| I

[ Add New




User

List Users
Home » Admin » User » User list

The list displays all users. The list is configurable, it is possible to filter the content and selecting
columns.

You can send a mail to a user, Edit a user or View a user.

View User
Home » Admin » User » View user

View Users shows detailed information about a user:

Both the standard information — like first name/last name, email, status, group role.

And information about what the user is involved with — like his licences, projects and statistics of
previous bookings.

! Edit user First name: Y_ujia
Last name: Jing

Username:
- Password:
4 Email: yujia@stur
no iImage Phone:
Mobile phone: 07658389
Gender: Male
Birth date: 1985-07-
User category: Undergrac
i Back 1 | Printable version ] [ Save as word University / Company: Chalmers
Department: Microtechr
Laboratory / Group: BiocNano £
Active/Not active history Status: Active
200902 - 200902 Not active Roles: User
200903 - Active
Access hours: Office Hou
Laboratory group history Area restriction: No Restric
Coat ber:
200902 - BioNano Systems Laboratory i
- Supervisor: Bjorn Cal
Area restriction history
B resmn?“" hister Access card nr: T00025 S¢
200902 - No Restrictions Introduction and safety course: 2009-02-1
Handle chemical course: 2009-02-1

Licence history
20100407 (621) Electroplating- Acid - .
20090401 (400) Sputter - FHR MS150 AETRBENE.

- BioNano Systems Laboratory

Statistics



Add/Edit User
Home » Admin » User » Add user

Add/Edit User changes the standard information about a user, or adds a new user.

Add/Edit user

First name: Yujia

User status: Active B
Last name: Jing Rol
oles:
User name: @ User
Email: Change Email Administrator
Phone, work: Project manager
Phone, mobile: 0765838988 Project leader (can't add project)
Instructor
Gender: 9 Male () Female Tool Responsible
Birth date (yyyy-mm-dd): ; Portal roles:
User category: Undergraduate student E
Laboratory / Group: BioNano Systems Laboratory Change
Accass hotirss Office Hours C:J Bookable as resource (Applies only to this user, to book man hours on project)
Area restriction: No Restrictions B
Coat No:

Practical coach: | Update || Cancel |

Supervisor: Bjorn Carlberg

Access card nr: T00025 96598

Introduction and safety course:  2009-02-17 B

Handle chemical course: 2009-02-17 B

Supplementary Info: Microtechnology Master
program.

Master thesis work

Most of the fields are “information only”, with no specific connection to the system, with a few
exceptions.

Laboratory / Group

This affects invoices, since different groups can have different fees.

If you change the “Laboratory/Group”, you choose “Make change from month” So in case you are in
the middle of a month, that group will still be debit for that user, that month.

User status

Active / Inactive / Deleted.

An Inactive user can still log in, but can not do anything in the system. A deleted user can not log in at
all. (Though, a deleted user can be set back to active again)

Roles
A role determinates what a user can see or do in the system.
More info at: Roles of the system

Bookable as resource

This is a setting that gives the user the option to book/log time in projects.

Primary this function is for lab personnel that are active in different projects, where someone else
has booked. Project time by resource is found under [LINK]



User status
Home » Admin » User » User Status

User status is a list of users, based on their status, when they logged in the last time, and when they
last attended to a safety-/chemical course.

New users to approve/decline

There are two ways to become a user of LIMS.
1) An administrator creates an account.

2) The user fills out a membership application.

New applications ends up in this list, and users selected under System settings, email-settings, get an
email and see a notification when they log in, that there are applications to process.

New/Pending applications, is shown in a list on this page.



Process application
Home » Admin » User » New users to approve/decline

Page for processing an application is split in two parts:
The information that the applicant has entered, and fields corrected by administrator.

Approve new user

Input by applicant Corrected / completed information by administrator
User Name: wfan
First name: Fan Fan
Last name: Wu Wu
Gender: Male Male [+]
Birth-date (yyyy-mm-dd):  1980-10-30 1980-10-30
Type of user: Researcher Researcher B
Company / University: mMC2
Department: mMC2
Laboratory / Group — Select laboratory / group - E
Project name: — Select project —- 3
Project Id:
Practical Coach:
Supervisor: Per Delsing Per Delsing
Access card number:
Start Date:
End Date:
Access hours: Office Hours Office Hours E
Area restriction: No Restrictions No Restrictions [ |
Overall number:
Supplementary Info:
Email: wfan@chalmers wfan@chalmers_se
Phone:
Mobile:

There are three options for an application:

The administrator declines the application, when an application is declined a message is sent to the
user explaining why he/she won’t be granted access.

The administrator can save the application as pending — for example, he completes the fields, but
wants the user to go a course before the user gets access.

He can save and approve the user to use the system.

Unlock user
Home » Admin » User » Unlock user

The system has a built in security, to prevent “brute force” — this means, if a user enters an invalid
password five times in a row, they account is locked. An administrator can from this page “unlock” it.



Info

m_ As a logged in user, this is what you see.

Area / room list

Chemical list

General documents

Tool documents

Sitemap

Area / room list
Home » Info » Area / room list

As a not logged in user, you only see General documents and sitemap.

As the name indicates, this is a list with all areas in the lab.

Optional filters for this list

(Hide filters...)

Responsible:

- All room responsibles —- El

Add/remove columns (3 of 5 columns chosen)

| | Name I Area A Room responsible Supplementary info
Edit Saw room Peter Modh
Edit MBE-Lab Peter Modh
Edit [Not defined] 0 MigrationUser MigrationUser Area/room created for
Edit Processlab 2 240 Peter Modh
Edit Processlab 1 1000 Peter Modh

Show Page: 1 (Total Records: 5)

General documents

Home » Info » General documents

List documents

| Edit I Delete | Documents

Info a

Edit
Edit
Edit

Edit
Edit
Edit
Edit

Delete
Delete
Delete

Delete
Delete
Delete
Delete

cleanwater sections.jpg [info]
nflvacationplan2010.pdf [info]
Fbladgrav0211.pdf [info]

marking2010.pdf [info]
labmanual.pdf [info]
solventspll.pdf [info]

MC2 Safety policy.doc [info]

Information from Sahlgrenska sjukhuset concerning working environment and
pregnancy.

Instructions for personal items marking 2010.

Introduction & Safety Manual

Report of exposure of solvent in Processlab 1

The MC2 safety policy as published in 2001

| Show Page: 1 (Total Records: 7)

@ Records Per Page: 10 E] |

Add New

General documents are both viewable as logged in or anonymous user.

Only a user with the role “administrator” can add, edit or delete documents.



Add/Edit document

9 physical document Physical document
Link to document 9 Link to document

Physical document Link to document

File Name: [ Bladdra.. | Link Name *

Info about document: K Link Path *

Info about document:

@]! Cancel -
@ Cancel |

You can add two types of documents:

Physical document, or link to document.

In the first case, you select a file, and uploads it —in the second case, you point out a document on a
network or on the internet.

Chemical list
Home » Info » Chemical list

Optional filters for this list  (Hide filters...) &
Name: Category: - All categories - E]
Supplier: Responsible: - All responsibles — E}

Apply filters

Add/remove columns (10 of 11 columns chosen)

Delete ‘ Name & Ali C v Ii | Responsibl: ‘ D t: Info about ch
Edit Delete Add/edit AZ 1500 Photoresist Clariant Kaija az_1500_series.pdf [info] The AZ1500 i
documents Photoresist Matikainen felmeddelande_svensak.txt [info] tone photores
Testsida [info] responds to tl
spectrum fron
am.

Edit Delete Add/edit AZ 4500 Photoresist Clariant Kaija az_4500_series.pdf [info] AZ 4500 is 3|
documents Photoresist Matikainen photoresist in
applications v
thicknesses a

required.
Edit Delete Add/edit LOR and Photoresist MicroChem Kaija PMGI-Resists.pdf [info] LOR and PMG
documents PMGI Matikainen used as a sac
resists as an undercu

layer lift-off p

I Show Page: 1 (Total Records: 4)

A standard user can view the list, and see the documents attached. An administrator, tool
responsible or instructor can add new chemicals to the list, and attach documents to the chemicals in
the list. Add a document works the same way as it does for a general document.



Tool documents
Home » Info » Tool documents

List tool documents

Tool document list

Optional filters for this list  (Hide filters...)

2

Tool Id: Tool name:

Tool category: Lithography E Responsible: - All tool responsible -- E'

Apply filters

Tool Id o | Tool name I C v . D. s

Add/edit documents 201 Photolithography Stepper - ASML PAS 2500 Lithography Johan Andersson

Add/edit documents 205 Mask aligner - KS MA/BA 6, #1 Lithography Johan Andersson tool205_short.docx [inf

Add/edit documents 210 Mask aligner - KS MIB3-UV 400 Lithography John Halonen 0OM210V7pdf.pdf [info]
IROMV3pdf.pdf [info]

Add/edit documents 213 Mask aligner - KS MA/BA 6, #2 Lithography Johan Andersson tool213_short.docx [inf

Add/edit documents 214 Resist spinner - S5T20 Lithography Johan Andersson productinfo_OPTIspin_S
KA0650_Chapter09_Sofi

Add/edit documents 217 EBL - JEOL JBX-S300FS Lithography Bengt Nilsson 01 06210263_EB93FS-3(

02 06210142 EB93FS-G!
04 06210235_EB93FS-LC
03 06210218 _EB93FS-H(
05 06110535_EBO93FS-M,
06 06210245_EB93-EBM
Alignment marks for JB)
Pieceholders for JBX930

Add/edit documents 222 Mask aligner - KS MIB2 Lithography John Halonen 0OM222V7.pdf [info]
Add/edit documents 224 Mask aligner - KS MIB3-DUV Lithography John Halonen 0OM224V6pdf.pdf [info]

“Tool documents” lists all tools and belonging documents.
A logged in user can view the list and get the documents —an admin or tool responsible can add or
edit documents.

Add / edit documents

9 Physical document
) Link to document
Physical document

File Name: Bladdra...
Tool Document Type:  * | Tool Manual E]

Info about document: -

Add Cancel

Adding document for a tool works the same way as for adding a General document or a Chemical
document. But in addition, you also have to choose type of document:

Control Specification, Recipe, Service Instructions, Technical Description, Tool Manual, or User
Instructions



Sitemap
Home » Info » Sitemap

Tools

My licenced tools (See list over tools where you have licence)
Apply for licence (Make an application for a licence)
All tools ( See list of all tools in lab)
Tool status (See list of status for all tools in lab)
View bookings (Manage bookings)
= My bookings (See list of your bookings)
= All bookings (See list over tools in order to see when tool is booked)
= Booking overview (See view over tools in order to see when tool is booked)
Batches (Manage batches)
= Batch list (Find the batch owner for a given batch id)
= Add batch (Add new batch)
= Log history by batch (View history for batches that you or project you belong to have created)
= Log history by tool (View log history for tool)
Log (Manage logs)
= Log status (Log status for booked and unbooked tools.)
= Log history by tool (View log history for tool)
= Log history by batch (View history for batches that you or project you belong to have created)
Verify night shift bocking (Make a new booking of tool for night shift)

User

My profile (View and edit your profile)

My statistics (See your statistics)

Send message (Send message to users and admin personell of this lab )
User list (See list of users)

Advanced

* Tool responsible (Functions for tool responsible)
= My tools (Administrate your tools)
= Tool timeblocking (Block time on tool)
= Allow/Disallow mail subject "booking cancelled" (Allow/Disallow mail subject "booking cancelled")
= Licences by user (Administrate licences by user)

Sitemap shows all accessible pages to the user.
This does not include pop-up windows, like booking view, send message.



Membership
Researchers, graduates, students and others that require access to the lab(s) can apply for
membership from the start page by clicking the menu “Membership”.

[ oois | tnto | Hembershin]

Home » Memb

Applying for membership is done in two steps.

In the first step the applier enters name, age university etc.
As seen below, the mandatory fields are First name, Last name and Age.
The user that grants membership to LIMS will probably require more data to be entered.

Apply for access to this lab

Step 1 of 2: Name and lab information |

First name: | [First name

Enter your first name(s)
Last name:
Gender: Male =

Birth-date (yyyy-mm-dd): *
Type of user: — Select type of user — ~
Company / University:

Department:

Laboratory / Group:

Project name:

Project Id:

Practical Coach:

Supervisor:

Access card number:

Start date (yyyy-mm-dd):

End date (yyyy-mm-dd):

Area restriction: No Restrictions ~

Supplementary Info:

1 agree that this lab saves birth date and gender information about me. *

In step two of the membership process the applier enters user name, password and telephone
numbers. The applier clicks the button “Finish” to send the application. Users responsible for process
user applications receive a message that there are new membership applications. These users are set
in system settings by an administrator.

Apply for access to this lab

Step 2 of 2: Username, password and contact
information

[Help ]

Username: ; Username and password are what you will
login with if your application is approved.
Password:
The password must be at least 3 characters
Confirm Password: long
Email:
Phone, work:

Phone, mobile:

Previous Finish



Booking in LIMS

The booking rules in LIMS consists of some system settings telling when over all booking is possible,
some tool settings telling how a certain tool can be booked, and some special rules that can be
temporary applied when wanted.

System settings
Admin -> System Info -> System settings

Booking settings: This is the general rules for booking, and applies to all users of the system.

E-mail Settings

Invoice settings

Booking settings

Nightshift start: 18[+]
- Nightshift stop: 07 E]
Start view, bookings Show bookings for yesterday and todayEl
Missing log(s) for bookings with mandatory logging: Always allow booking E]

Change log Don' allow to change start time on started log E] I

Save settings

Public tool list

General settings

Nightshift start and stop

In this case, a booking made between 07 and 18 is considered a “daytime booking”, while a booking
between 18 and 07 is a nighttime.

At nighttime, you are not allowed to be alone in the lab — just must have a so called “Lab buddy”.
There can also be a difference in the amount of time you can book for a tool at day or at night.
(Those settings are made at tool-level)

Startview, bookings
Default sorting on startpage, when a user log in.

Missing log(s) for bookings with mandatory logging
You can force the user to log his previous bookings, before he’s allowed to create a new.

Change log
Allow user to change start time on an existing log.



Tool settings
Admin -> Tools -> Tool list: Edit tool

Among the tool information, there are also the booking rules.
Here you apply rules at the level of a certain tool. (Preferable done by a tool responsible)

Minimum minutes per booking: 30
Max hours per day: 6
Max hours per night: 12
Future allocation limit, day time: 12
Future allocation limit, night time: 12
Nr of future bookings allowed: 6

Minumum minutes per booking
The least time you can do a booking.

Max hours per day / night
Total time a single user can book this equipment at day time / night time (systemsetting)

Future allocation limit, day time / night time

The total time a user can book this equipment in the future.

Ex: If the user makes a booking for later today at day time, one for tomorrow day time for 6 hours,
and one booking the day after that for 6 hours, he will get an error due to “future allocation limit,
day time”. But, as soon as the time has passed for the booking today, he will be able to book again.

Nr of future bookings allowed

This can be for the occation, when a user tries to trick the system, doing bookings like:
07.00-07.30, 08.00-08.30.....12.00-12.30, 13.00-13.00.....18.00-18.30 — only booking a total of 6
hours, but “blocking” the tool for 12 hours.



Tool blocking

A tool can be blocked from booking during timespans — for example if you want to save spaces for
last minute bookings. A blocking will be released at a predefined time.

Choose period

Start 2010-05-27 £
Stop 2013-05-03 7
Choose Time

Start 12:00(~|

Stop 16:00 [~ |

Choose Days

[VIMon ¥Tue Mwed I Thu [CIFri [C]sat [Clsun
Choose time before release

Hours 4

Reason for block.

Reserved for "last -
minute"-bookings

One scenario: An equipment shall not be bookable Monday to Thursday, between 12.00 an 16.00.
Four hours before start time, the whole block will be released, and the time bookable

“Period” tells between which dates this block is valid.

Area shutdown

An area of the lab can be temporary shutdown. During shutdown, no equipment that is standing in
that area is bookable until shutdown is over or canceled.
This applies to all users.

Area Room Id: Processlab 1 E|
From Time: 2010-06-08 08:00
To Time: 2010-06-09 08:00

Closedown Reason: changeing the waterpipes



Exceptions
As earlier mentioned, “system settings” and “Area shutdown” applies to all users. The rest comes
with exceptions.

Administrator

A user with the role administrator can do anything in the system. This also applies to bookings.

An administrator doesn’t need a license to do a booking, and he has no limitations in bookingtime or
numbers of bookings. He can remove/change a users bookings, or overwrite them with his own.

Tool responsible
A tool responsible is like an administrator. He has no limitations on his own tools, but on other tools
the same rules applies as for other users.

Member of service project

If the user is member of a service project, he can override bookings — but only if the project he is
booking on is of the type “service”, and he has got a license for the tool.

Also, if you are a member of the service project, the “time blocking” does not apply — you can book
anyway.

Overriding bookings
There are levels of how you can change/override an existing booking.
Is a standard user tries to click at a time already booked, he will get a message that the time has
already been taken — and the option to send a message to the user who has the booking.
If an admin / tool responsible / service-member does
the same, the following will show:

Bookinginformation

1 bookings affected. )
Several choices are possible! given if you are a _) Make a service booking
Select one from below

These choises is only

toolresponsible or ) Send message.

. . han kin
admin. If you are in the Change booking
Overbook. (removes affected bookings) serviceproject, you will

) Send message. instead get these choises:
7) Change booking

Cancel

“Make a service booking” or “Send a message”.

(Change booking is disabled)

In the case or “Overbook” or “Make service booking” all affected bookings will be removed
permanently.



